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บทน ำ 

 

1.1 ช่ือและทีต่ั้งของสถำนประกอบกำร 
ช่ือภาษาไทย  : บริษทั ดิจิโอ (ประเทศไทย) จ ากดั  

ช่ือภาษาองักฤษ  : Digio (Thailand) Company Limited     

 
 

 
 
 

รูปที ่1.1 แผนท่ีบริษทั ดิจิโอ (ประเทศไทย) จ ากดั 
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1.2 ลกัษณะธุรกจิของสถำนประกอบกำร หรือกำรให้บริกำรหลกัขององค์กร 
 
1.2.1 ควำมเป็นมำของบริษัทและบริกำรของบริษัท  

บริษทั ดิจิโอ (ประเทศไทย) ไดก่้อตั้งข้ึนในปี พ.ศ. 2555 โดยคุณนพพร ด่านชยันามด ารง 
ต าแหน่งกรรมการผูจ้ดัการบริษทั มีประสบการณ์ทางดา้นการพฒันา โมบาย แอปพลิเคชัน่ และการ 
พฒันาระบบระบบสารสนเทศต่างๆ เป้าหมายของบริษทัคือ การเป็นผูใ้หบ้ริการทางดา้นเทคโนโลยี 
สารสนเทศเป็นผูเ้ช่ียวชาญทางดา้นธุรกรรมทางการเงินผา่นทางโทรศพัทมื์อถือ โดยทีมงานท่ีมี
ประสบการณ์ ในแต่ละดา้นแตกต่างกนัออกไปและมีบริษทัร่วมคือบริษทั ซอฟตส์เปซเอสเอ็นดีบี
เฮช เป็นการร่วมงานกนัอยา่งลงตวัของบริษทัพฒันาซอฟตแ์วร์ประเทศไทยและ บริษทัของมาเลเซีย
ซ่ึงเป็นผูบุ้กเบิกเทคโนโลยีรับช าระเงินผา่นทางมือถือบนแพลตฟอร์ม ไอโอเอส, แอนดรอยด์ และ 
วนิโดว ์ ท าใหอุ้ปกรณ์โทรศพัทมื์อถือสามารถรับช าระเงินผา่นบตัรเครดิตอยา่ง ปลอดภยัดว้ยการ
เขา้รหสัขอ้มูลหลายชั้นและท าธุรกรรมภายใตม้าตรฐานความปลอดภยั 

 

1.3 รูปแบบกำรจัดองค์กรและกำรบริหำรองค์กร  
 

 
 

รูปที ่1.2  แผนพงัการบริหารของบริษทั 
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1.4 ต ำแหน่งและหน้ำทีง่ำนทีนั่กศึกษำได้รับมอบหมำย 
ต าแหน่ง : Developer  
หนา้ท่ี : รับผดิชอบการพฒันาส่วนติดต่อกบัผูใ้ชง้านตามแบบท่ีไดรั้บ 
  มอบหมายและทดสอบเคร่ืองมืออ่านบตัรเครดิต  

 
1.5 พนักงำนทีป่รึกษำ และ ต ำแหน่งของพนักงำนทีป่รึกษำ 
 พนกังานท่ีปรึกษา : นายธญันภทัร์ กงัวานสิทธ์ิสร 
 ต าแหน่ง  : Developer 
  
1.6 ระยะเวลำทีป่ฏบิัติงำน 
 เร่ิมปฏิบติังาน  : วนัท่ี 2 มิถุนายน 2558  

ส้ินสุดการปฏิบติังาน : วนัท่ี 30 กนัยายน 2558  
รวมระยะเวลาทั้งส้ิน : 4 เดือน 

 
1.7 วตัถุประสงค์หรือจุดมุ่งหมำยของกำรปฏบัิติงำนหรือโครงงำนทีไ่ด้รับมอบหมำย
ให้ปฏบิัติงำนสหกจิศึกษำ 
 1) เพื่อการเรียนรู้ท างานจริงในสายงานดา้นการพฒันาซอฟตแ์วร์ 
 2) เพื่อการฝึกฝนการพฒันาการออกรายงานดว้ย คริสตลั รีพอร์ท 
 3) เพื่อการออกแบบ ส่วนของผูใ้ชง้าน เวบ็ แอปพลิเคชัน่ ดว้ยบูทสแตรป 
 
1.8 ผลทีค่ำดว่ำจะได้รับจำกกำรปฏบิัติงำนหรือโครงงำนทีไ่ด้รับมอบหมำย 

1) ไดรั้บความรู้ในการท า คริสตลัรีผอด เพื่อน าไปใชต่้อยอดในการเรียนรู้ แซป (Systems 
Applications and Products in Data Processing: SAP) ในอนาคต 
2) ไดรั้บความรู้ในการออกแบบส่วนของผูใ้ชง้านเวบ็ไซตแ์บบยดืหยุน่ดว้ย บูทสแตรป 
3) ไดรั้บประสบการณ์ในการท างาน และเรียนรู้การเขา้สังคมในท่ีท างาน ซ่ึงเป็นประโยชน์ 
ต่อการท างานในอนาคต 

 



บทที ่2 

ทฤษฎแีละเทคโนโลยทีีใ่ช้ในการปฏิบัตงิาน 

 

2.1 ไมโครซอฟท์ วชิวล สตูดิโอ (Microsoft Visual Studio) 

ไมโครซอฟท์ วิชวลสตูดิโอ คือ ส่ิงแวดลอ้มส ำหรับกำรพฒันำแบบเบ็ดเสร็จ (Integrated 

Development Environment: IDE) พัฒนำข้ึนโดยไมโครซอฟท์ ซ่ึงเป็นเคร่ืองมือช่วยนักพฒันำ

ซอฟต์แวร์ พฒันำโปรแกรมคอมพิวเตอร์ เว็บไซต์ เว็บแอปพลิเคชัน และ เว็บเซอร์วิซ ระบบท่ี

รองรับกำรท ำงำนนั้นมีไมโครซอฟท์ วินโดวส์ พ็อคเกตพีซี สมำร์ทโฟน และ เวบ็เบรำวเ์ซอร์ ใน

ปัจจุบนั วิชวลสตูดิโอนั้นสำมำรถใช้ภำษำโปรแกรมท่ีเป็นภำษำดอตเน็ต ในโปรแกรมเดียวกัน 

เช่น VB.NET C++ C# J# เป็นตน้ 

 

รูปที ่2.1 โลโก ้วชิวล สตูดิโอ 

 

 

รูปที ่2.2 โปรแกรม วชิวล สตูดิโอ 

https://th.wikipedia.org/wiki/Integrated_Development_Environment
https://th.wikipedia.org/wiki/Integrated_Development_Environment
https://th.wikipedia.org/wiki/%E0%B9%84%E0%B8%A1%E0%B9%82%E0%B8%84%E0%B8%A3%E0%B8%8B%E0%B8%AD%E0%B8%9F%E0%B8%97%E0%B9%8C
https://th.wikipedia.org/wiki/%E0%B8%99%E0%B8%B1%E0%B8%81%E0%B8%9E%E0%B8%B1%E0%B8%92%E0%B8%99%E0%B8%B2%E0%B8%8B%E0%B8%AD%E0%B8%9F%E0%B8%95%E0%B9%8C%E0%B9%81%E0%B8%A7%E0%B8%A3%E0%B9%8C
https://th.wikipedia.org/wiki/%E0%B8%99%E0%B8%B1%E0%B8%81%E0%B8%9E%E0%B8%B1%E0%B8%92%E0%B8%99%E0%B8%B2%E0%B8%8B%E0%B8%AD%E0%B8%9F%E0%B8%95%E0%B9%8C%E0%B9%81%E0%B8%A7%E0%B8%A3%E0%B9%8C
https://th.wikipedia.org/wiki/%E0%B9%82%E0%B8%9B%E0%B8%A3%E0%B9%81%E0%B8%81%E0%B8%A3%E0%B8%A1%E0%B8%84%E0%B8%AD%E0%B8%A1%E0%B8%9E%E0%B8%B4%E0%B8%A7%E0%B9%80%E0%B8%95%E0%B8%AD%E0%B8%A3%E0%B9%8C
https://th.wikipedia.org/wiki/%E0%B9%80%E0%B8%A7%E0%B9%87%E0%B8%9A%E0%B9%84%E0%B8%8B%E0%B8%95%E0%B9%8C
https://th.wikipedia.org/wiki/%E0%B9%80%E0%B8%A7%E0%B9%87%E0%B8%9A%E0%B9%81%E0%B8%AD%E0%B8%9B%E0%B8%9E%E0%B8%A5%E0%B8%B4%E0%B9%80%E0%B8%84%E0%B8%8A%E0%B8%B1%E0%B8%99
https://th.wikipedia.org/wiki/%E0%B9%80%E0%B8%A7%E0%B9%87%E0%B8%9A%E0%B9%80%E0%B8%8B%E0%B8%AD%E0%B8%A3%E0%B9%8C%E0%B8%A7%E0%B8%B4%E0%B8%8B
https://th.wikipedia.org/wiki/%E0%B9%84%E0%B8%A1%E0%B9%82%E0%B8%84%E0%B8%A3%E0%B8%8B%E0%B8%AD%E0%B8%9F%E0%B8%97%E0%B9%8C_%E0%B8%A7%E0%B8%B4%E0%B8%99%E0%B9%82%E0%B8%94%E0%B8%A7%E0%B8%AA%E0%B9%8C
https://th.wikipedia.org/wiki/%E0%B8%9E%E0%B9%87%E0%B8%AD%E0%B8%84%E0%B9%80%E0%B8%81%E0%B8%95%E0%B8%9E%E0%B8%B5%E0%B8%8B%E0%B8%B5
https://th.wikipedia.org/wiki/Smartphone
https://th.wikipedia.org/wiki/%E0%B9%80%E0%B8%A7%E0%B9%87%E0%B8%9A%E0%B9%80%E0%B8%9A%E0%B8%A3%E0%B8%B2%E0%B8%A7%E0%B9%8C%E0%B9%80%E0%B8%8B%E0%B8%AD%E0%B8%A3%E0%B9%8C
https://th.wikipedia.org/wiki/%E0%B8%A0%E0%B8%B2%E0%B8%A9%E0%B8%B2%E0%B9%82%E0%B8%9B%E0%B8%A3%E0%B9%81%E0%B8%81%E0%B8%A3%E0%B8%A1
https://th.wikipedia.org/wiki/%E0%B8%A0%E0%B8%B2%E0%B8%A9%E0%B8%B2%E0%B8%94%E0%B8%AD%E0%B8%95%E0%B9%80%E0%B8%99%E0%B9%87%E0%B8%95
https://th.wikipedia.org/wiki/VB.NET
https://th.wikipedia.org/wiki/%E0%B8%A0%E0%B8%B2%E0%B8%A9%E0%B8%B2%E0%B8%8B%E0%B8%B5%E0%B8%9E%E0%B8%A5%E0%B8%B1%E0%B8%AA%E0%B8%9E%E0%B8%A5%E0%B8%B1%E0%B8%AA
https://th.wikipedia.org/wiki/%E0%B8%A0%E0%B8%B2%E0%B8%A9%E0%B8%B2%E0%B8%8B%E0%B8%B5%E0%B8%8A%E0%B8%B2%E0%B8%A3%E0%B9%8C%E0%B8%9B
https://th.wikipedia.org/w/index.php?title=%E0%B8%A0%E0%B8%B2%E0%B8%A9%E0%B8%B2%E0%B9%80%E0%B8%88%E0%B8%8B%E0%B8%B2%E0%B8%A3%E0%B9%8C%E0%B8%9B&action=edit&redlink=1
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2.2 แบรคคทิ (Brackets)  

โปรแกรม แบรคคิท เป็นโปรแกรมแก้ไข เขียนโค้ด ส ำหรับ โปรแกรมเมอร์ หรือ 
ผูพ้ฒันำโปรแกรม ในภำษำต่ำง ๆ ใชง้ำนง่ำย โดยจะเนน้ไปทำงกำรท ำเวบ็ไซต ์สนบัสนุนภำษำเฮช
ทีเอม็แอล (HTML) ซีเอสเอส (CSS) จำวำสคริป (Javascript)  

 

 
รูปที ่2.3 โลโก ้แบรคคิท 

 

 

รูปที ่2.4 โปรแกรม แบรคคิท 
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2.3 อะโดบี อลิลสัเตรเตอร์ (Adobe Illustrator) 

 เป็นโปรแกรมวำดภำพกรำฟิกแบบเวกเตอร์ ซ่ึงพฒันำโดยบริษทัอะโดบีซิสเต็มส์ รุ่นแรก 

จดัท ำข้ึนในปี ค.ศ. 1986 เพื่อใชง้ำนกบัเคร่ืองแมคอินทอช และไดพ้ฒันำรุ่นท่ี 2 ออกมำใหใ้ชง้ำนได้

กบัวินโดวส์ ซ่ึงไดรั้บควำมพึงพอใจ และ กำรตอบรับท่ีดีจำกผูใ้ช้เป็นจ ำนวนมำก จนปัจจุบนัได้

พฒันำออกมำจนถึงรุ่นท่ี 16 

 

 

รูปที ่2.5 โลโกโ้ปรแกรม อะโดบี อิลลสัเตรเตอร์ 

 

 

รูปที ่2.6 โปรแกรม อะโดบี อิลลสัเตรเตอร์ 

 

 

https://th.wikipedia.org/w/index.php?title=%E0%B8%A0%E0%B8%B2%E0%B8%9E%E0%B8%81%E0%B8%A3%E0%B8%B2%E0%B8%9F%E0%B8%B4%E0%B8%81%E0%B9%81%E0%B8%9A%E0%B8%9A%E0%B9%80%E0%B8%A7%E0%B8%81%E0%B9%80%E0%B8%95%E0%B8%AD%E0%B8%A3%E0%B9%8C&action=edit&redlink=1
https://th.wikipedia.org/wiki/%E0%B8%AD%E0%B8%B0%E0%B9%82%E0%B8%94%E0%B8%9A%E0%B8%B5%E0%B8%8B%E0%B8%B4%E0%B8%AA%E0%B9%80%E0%B8%95%E0%B9%87%E0%B8%A1%E0%B8%AA%E0%B9%8C
https://th.wikipedia.org/wiki/%E0%B8%84.%E0%B8%A8._1986
https://th.wikipedia.org/wiki/%E0%B9%81%E0%B8%A1%E0%B8%84%E0%B8%AD%E0%B8%B4%E0%B8%99%E0%B8%97%E0%B8%AD%E0%B8%8A
https://th.wikipedia.org/wiki/Microsoft_Windows
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2.4 คริสตัล รีพอร์ท (Crystal Report) 

เคร่ืองมือท่ีใชใ้นกำรออกรำยงำน ซ่ึงสำมำรถ ออกรำยงำนไดห้ลำกหลำย รูปแบบ ทั้งแบบ 

รำยงำนธรรมดำ แบบตำรำง และแบบอ่ืน ๆ ซ่ึงมีเคร่ืองมือท่ีออกแบบมำให้ง่ำยต่อกำรใชง้ำน และ

กำรติดต่อกบัฐำนขอ้มูลก็สำมำรถท ำได้หลำกหลำยตลอดจนสำมำรถน ำข้อมูลจำก วิวเวอร์ของ

เคร่ืองมำดูก็สำมำรถท ำได ้ซ่ึงให้ควำมสำมำรถท่ีหลำกหลำย และกำรดู ก็สำมำรถดูไดห้ลำกหลำย 

เช่น กำรดูผำ่นตวัโปรแกรมเอง  กำรดูผำ่นโปรแกรมท่ีเป็น โปรแกรมประยกุตท่ี์ ซอฟแวร์ เฮำ้ส์ ต่ำง 

ๆ ผลิตข้ึนมำ หรือแมก้ระทั้ง ดูบนเวบ็ ซ่ึงจำกควำมสำมำรถท่ีหลำกหลำยดงักล่ำวจึงเป็นท่ีนิยมใช้

งำนในเชิงพำณิชยก์นั 

 

2.5 ไมโครซอฟท์ เอสควิแอลเซิร์ฟเวอร์ (SQL Server Management) 

ระบบจดักำรฐำนข้อมูลพฒันำโดยไมโครซอฟท์ ซ่ึงใช้ภำษำ ที-เอสคิวแอล (T-SQL) ใน

กำรดึงเรียกขอ้มูล 

 

2.6 แซมป์ (Xampp) 

 โปรแกรมส ำหรับจ ำลองเคร่ืองคอมพิวเตอร์ส่วนบุคคล ให้ท ำงำนในลกัษณะของ เว็บ

เซิร์ฟเวอร์ คือเคร่ืองคอมพิวเตอร์จะเป็นทั้งเคร่ืองแม่ และเคร่ืองลูกในเคร่ืองเดียวกนั ท ำให้ไม่ตอ้ง

เช่ือมต่อกบัอินเทอร์เน็ต สำมำรถทดสอบเวบ็ไซต์ท่ีสร้ำงข้ึน ไดทุ้กท่ีทุกเวลำ ปัจจุบนัไดรั้บควำม

นิยมจำกผูใ้ชเ้วบ็ไซตส์ ำเร็จรูป (Content Management System : CMS ) ในกำรสร้ำงเวบ็ไซต ์ 

 

2.7 เอชทเีอม็แอล (Hypertext Markup Language: HTML) 

ภำษำคอมพิวเตอร์ท่ีใชใ้นกำรแสดงผลของเอกสำรบน เวบ็ไซต ์หรือท่ีเรำเรียกกนัวำ่เวบ็เพจ 

ถูกพฒันำและก ำหนดมำตรฐำนโดยองค์กร เวิลด์ ไวด์ เว็บ คอนซอร์เทียม (World Wide Web 

Consortium: W3C) และจำกกำรพฒันำทำงดำ้นซอฟต์แวร์ของไมโครซอฟท์ท ำให้ภำษำ เฮซทีเอ็ม

https://th.wikipedia.org/wiki/%E0%B8%A3%E0%B8%B0%E0%B8%9A%E0%B8%9A%E0%B8%88%E0%B8%B1%E0%B8%94%E0%B8%81%E0%B8%B2%E0%B8%A3%E0%B8%90%E0%B8%B2%E0%B8%99%E0%B8%82%E0%B9%89%E0%B8%AD%E0%B8%A1%E0%B8%B9%E0%B8%A5
https://th.wikipedia.org/wiki/%E0%B9%84%E0%B8%A1%E0%B9%82%E0%B8%84%E0%B8%A3%E0%B8%8B%E0%B8%AD%E0%B8%9F%E0%B8%97%E0%B9%8C
https://th.wikipedia.org/w/index.php?title=T-SQL&action=edit&redlink=1
https://th.wikipedia.org/wiki/%E0%B9%84%E0%B8%A1%E0%B9%82%E0%B8%84%E0%B8%A3%E0%B8%8B%E0%B8%AD%E0%B8%9F%E0%B8%97%E0%B9%8C
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แอลเป็นอีกภำษำหน่ึงท่ีใช้เขียนโปรแกรมได้ หรือท่ีเรียกว่ำ เฮซทีเอ็มแอล  แอปพลิเคชัน 
 

 

2.8 ซีเอสเอส (Cascading Style Sheets: CSS) 

เป็นภำษำท่ีมีรูปแบบกำรเขียนท่ีเฉพำะ และถูกก ำหนดมำตรฐำนโดย W3C เช่นเดียวกบั 

เฮซทีเอ็มแอล และ เอ็กซ์เฮซทีเอ็มแอล    ใช้ส ำหรับตกแต่งเอกสำรเฮซทีเอ็มแอล และ เอ็กซ์เฮซ

ทีเอ็มให้มีหน้ำตำ สีสัน ตวัอกัษร เส้นขอบ พื้นหลงั ระยะห่ำง ฯลฯ อย่ำงท่ีเรำตอ้งกำร ด้วยกำร

ก ำหนดคุณสมบติัใหก้บัธำตุต่ำง ๆ ของเฮซทีเอม็แอล เช่น <body> <p> <h1> เป็นตน้ 

 

2.9 จาวาสคริป (JavaScript) 

 เป็นภำษำท่ีเป็น สคริป ท่ีอยูใ่นเวบ็ไซต ์ใช่ร่วมกบั เฮซทีเอม็แอล เพื่อใหเ้วบ็ไซตข์องมีกำร

เคล่ือนไหว สำมำรถตอบสนองผูใ้ชง้ำนไดม้ำกข้ึน ยกตวัอยำ่ง Hellomyweb.com เมนูดำ้นซำ้ยมือจะ

เห็นว่ำสำมำรถคลิกเพื่อดูหัวขอ้ภำยในได้ และสำมำรถคลิกท่ีลูกศรสีเขียวเพื่อปิดดูทั้งหมด และ

ลูกศรสีแดงเพื่อเปิดทั้งหมด  

 

2.10 เจควิร่ี jQuery 

เป็นไลบรำร่ีของโคด้จำวำสคริปต์ท่ีรวบรวมเอำฟังก์ชัน่ และค ำสั่งต่ำง ๆ ของจำวำสคริปท่ี
เรำใชอ้ยูเ่ป็นประจ ำ โดยท่ีเรำไม่ตอ้งเขียนข้ึนมำใหม่ทั้งหมดตั้งแต่ตน้ และเรำสำมำรถท่ีจะเขียน อำ
แจ็กซ์ (ajax) ไดแ้บบง่ำย ๆ เพียงโคด้ไม่ก่ีบรรทดั หรือจะเขียนจำวำสคริปเพื่อดกัเหตุกำรณ์ต่ำงๆท่ี
เรำตอ้งกำร เช่น กำรคลิก กำรเคล่ือนท่ี และอ่ืน ๆ อีกมำกหมำย ซ่ึงถำ้เรำใช้จำวำสคริปตอ้งเขียน
ค ำสั่งหลำยบรรทดั  
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2.11 ซีชาร์ป (C#)  

เป็นภำษำโปรแกรมแบบหลำยโมเดล ท่ีใชร้ะบบชนิดขอ้มูลแบบรัดกุม (strong typing) และ

สนับสนุนกำรเขียนโปรแกรมเชิงค ำสั่ง กำรเขียนโปรแกรมเชิงประกำศ กำรเขียนโปรแกรมเชิง

ฟังก์ชนั กำรเขียนโปรแกรมเชิงกระบวนกำร กำรเขียนโปรแกรมเชิงวตัถุ แบบคลำส และกำรเขียน

โปรแกรมเชิงส่วนประกอบ พฒันำเร่ิมแรกโดยบริษทัไมโครซอฟท์เพื่อท ำงำนบนดอตเน็ตเฟรม

เวิร์ก โดยมีแอนเดอร์ เฮลส์เบิร์ก (Anders Hejlsberg) เป็นหัวหน้ำโครงกำร และมีรำกฐำนมำจำก

ภำษำซีพลสัพลสัและภำษำอ่ืน ๆ โดยเฉพำะภำษำเดลไฟและจำวำ โดยมีจุดมุ่งหมำยให้เป็นภำษำ

สมยัใหม่ท่ีไม่ซบัซอ้น ใชง้ำนไดท้ัว่ไป (general-purpose) และเป็นเชิงวตัถุเป็นหลกั 

 

2.12 ดอตเน็ตเฟรมเวร์ิก (.NET Framework) 

คือแพลตฟอร์มส ำหรับพฒันำซอฟต์แวร์สร้ำงข้ึนโดยไมโครซอฟท์ โดยรองรับภำษำ

ดอตเน็ตมำกกว่ำ 40 ภำษำ ซ่ึงมีไลบรำรีเป็นจ ำนวนมำกส ำหรับกำรเขียนโปรแกรม รวมถึงบริหำร

กำรด ำเนินกำรของโปรแกรมบนดอตเน็ตเฟรมเวิร์ก โดยไลบรำรีนั้นไดร้วมถึงส่วนต่อประสำนกบั

ผูใ้ช ้กำรเช่ือมต่อฐำนขอ้มูล วทิยำกำรเขำ้รหสัลบั ขั้นตอนวธีิ กำรเช่ือมต่อเครือข่ำยคอมพิวเตอร์ และ

กำรพฒันำเวบ็แอปพลิเคชนั 

 

2.13 เอเอสพดีอตเน็ต (ASP.NET) 

 คือเทคโนโลยสี ำหรับพฒันำเวบ็ไซต ์เวบ็แอปพลิเคชนั และเวบ็เซอร์วซิ ซ่ึงเป็นส่วนหน่ึง

ของดอตเน็ตเฟรมเวร์ิก พฒันำโดยไมโครซอฟท ์

 

https://th.wikipedia.org/wiki/%E0%B9%82%E0%B8%A1%E0%B9%80%E0%B8%94%E0%B8%A5%E0%B8%81%E0%B8%B2%E0%B8%A3%E0%B9%80%E0%B8%82%E0%B8%B5%E0%B8%A2%E0%B8%99%E0%B9%82%E0%B8%9B%E0%B8%A3%E0%B9%81%E0%B8%81%E0%B8%A3%E0%B8%A1#.E0.B8.A0.E0.B8.B2.E0.B8.A9.E0.B8.B2.E0.B9.82.E0.B8.9B.E0.B8.A3.E0.B9.81.E0.B8.81.E0.B8.A3.E0.B8.A1.E0.B8.AB.E0.B8.A5.E0.B8.B2.E0.B8.A2.E0.B9.82.E0.B8.A1.E0.B9.80.E0.B8.94.E0.B8.A5
https://th.wikipedia.org/w/index.php?title=%E0%B8%8A%E0%B8%99%E0%B8%B4%E0%B8%94%E0%B8%82%E0%B9%89%E0%B8%AD%E0%B8%A1%E0%B8%B9%E0%B8%A5%E0%B9%81%E0%B8%9A%E0%B8%9A%E0%B8%A3%E0%B8%B1%E0%B8%94%E0%B8%81%E0%B8%B8%E0%B8%A1&action=edit&redlink=1
https://th.wikipedia.org/wiki/%E0%B8%81%E0%B8%B2%E0%B8%A3%E0%B9%80%E0%B8%82%E0%B8%B5%E0%B8%A2%E0%B8%99%E0%B9%82%E0%B8%9B%E0%B8%A3%E0%B9%81%E0%B8%81%E0%B8%A3%E0%B8%A1%E0%B9%80%E0%B8%8A%E0%B8%B4%E0%B8%87%E0%B8%84%E0%B8%B3%E0%B8%AA%E0%B8%B1%E0%B9%88%E0%B8%87
https://th.wikipedia.org/w/index.php?title=%E0%B8%81%E0%B8%B2%E0%B8%A3%E0%B9%80%E0%B8%82%E0%B8%B5%E0%B8%A2%E0%B8%99%E0%B9%82%E0%B8%9B%E0%B8%A3%E0%B9%81%E0%B8%81%E0%B8%A3%E0%B8%A1%E0%B9%80%E0%B8%8A%E0%B8%B4%E0%B8%87%E0%B8%9B%E0%B8%A3%E0%B8%B0%E0%B8%81%E0%B8%B2%E0%B8%A8&action=edit&redlink=1
https://th.wikipedia.org/w/index.php?title=%E0%B8%81%E0%B8%B2%E0%B8%A3%E0%B9%80%E0%B8%82%E0%B8%B5%E0%B8%A2%E0%B8%99%E0%B9%82%E0%B8%9B%E0%B8%A3%E0%B9%81%E0%B8%81%E0%B8%A3%E0%B8%A1%E0%B9%80%E0%B8%8A%E0%B8%B4%E0%B8%87%E0%B8%9F%E0%B8%B1%E0%B8%87%E0%B8%81%E0%B9%8C%E0%B8%8A%E0%B8%B1%E0%B8%99&action=edit&redlink=1
https://th.wikipedia.org/w/index.php?title=%E0%B8%81%E0%B8%B2%E0%B8%A3%E0%B9%80%E0%B8%82%E0%B8%B5%E0%B8%A2%E0%B8%99%E0%B9%82%E0%B8%9B%E0%B8%A3%E0%B9%81%E0%B8%81%E0%B8%A3%E0%B8%A1%E0%B9%80%E0%B8%8A%E0%B8%B4%E0%B8%87%E0%B8%9F%E0%B8%B1%E0%B8%87%E0%B8%81%E0%B9%8C%E0%B8%8A%E0%B8%B1%E0%B8%99&action=edit&redlink=1
https://th.wikipedia.org/w/index.php?title=%E0%B8%81%E0%B8%B2%E0%B8%A3%E0%B9%80%E0%B8%82%E0%B8%B5%E0%B8%A2%E0%B8%99%E0%B9%82%E0%B8%9B%E0%B8%A3%E0%B9%81%E0%B8%81%E0%B8%A3%E0%B8%A1%E0%B9%80%E0%B8%8A%E0%B8%B4%E0%B8%87%E0%B8%81%E0%B8%A3%E0%B8%B0%E0%B8%9A%E0%B8%A7%E0%B8%99%E0%B8%81%E0%B8%B2%E0%B8%A3&action=edit&redlink=1
https://th.wikipedia.org/wiki/%E0%B8%81%E0%B8%B2%E0%B8%A3%E0%B9%80%E0%B8%82%E0%B8%B5%E0%B8%A2%E0%B8%99%E0%B9%82%E0%B8%9B%E0%B8%A3%E0%B9%81%E0%B8%81%E0%B8%A3%E0%B8%A1%E0%B9%80%E0%B8%8A%E0%B8%B4%E0%B8%87%E0%B8%A7%E0%B8%B1%E0%B8%95%E0%B8%96%E0%B8%B8
https://th.wikipedia.org/wiki/%E0%B8%84%E0%B8%A5%E0%B8%B2%E0%B8%AA_(%E0%B8%84%E0%B8%AD%E0%B8%A1%E0%B8%9E%E0%B8%B4%E0%B8%A7%E0%B9%80%E0%B8%95%E0%B8%AD%E0%B8%A3%E0%B9%8C)
https://th.wikipedia.org/w/index.php?title=%E0%B8%81%E0%B8%B2%E0%B8%A3%E0%B9%80%E0%B8%82%E0%B8%B5%E0%B8%A2%E0%B8%99%E0%B9%82%E0%B8%9B%E0%B8%A3%E0%B9%81%E0%B8%81%E0%B8%A3%E0%B8%A1%E0%B9%80%E0%B8%8A%E0%B8%B4%E0%B8%87%E0%B8%AA%E0%B9%88%E0%B8%A7%E0%B8%99%E0%B8%9B%E0%B8%A3%E0%B8%B0%E0%B8%81%E0%B8%AD%E0%B8%9A&action=edit&redlink=1
https://th.wikipedia.org/w/index.php?title=%E0%B8%81%E0%B8%B2%E0%B8%A3%E0%B9%80%E0%B8%82%E0%B8%B5%E0%B8%A2%E0%B8%99%E0%B9%82%E0%B8%9B%E0%B8%A3%E0%B9%81%E0%B8%81%E0%B8%A3%E0%B8%A1%E0%B9%80%E0%B8%8A%E0%B8%B4%E0%B8%87%E0%B8%AA%E0%B9%88%E0%B8%A7%E0%B8%99%E0%B8%9B%E0%B8%A3%E0%B8%B0%E0%B8%81%E0%B8%AD%E0%B8%9A&action=edit&redlink=1
https://th.wikipedia.org/wiki/%E0%B9%84%E0%B8%A1%E0%B9%82%E0%B8%84%E0%B8%A3%E0%B8%8B%E0%B8%AD%E0%B8%9F%E0%B8%97%E0%B9%8C
https://th.wikipedia.org/wiki/%E0%B8%94%E0%B8%AD%E0%B8%95%E0%B9%80%E0%B8%99%E0%B9%87%E0%B8%95%E0%B9%80%E0%B8%9F%E0%B8%A3%E0%B8%A1%E0%B9%80%E0%B8%A7%E0%B8%B4%E0%B8%A3%E0%B9%8C%E0%B8%81
https://th.wikipedia.org/wiki/%E0%B8%94%E0%B8%AD%E0%B8%95%E0%B9%80%E0%B8%99%E0%B9%87%E0%B8%95%E0%B9%80%E0%B8%9F%E0%B8%A3%E0%B8%A1%E0%B9%80%E0%B8%A7%E0%B8%B4%E0%B8%A3%E0%B9%8C%E0%B8%81
https://th.wikipedia.org/w/index.php?title=%E0%B9%81%E0%B8%AD%E0%B8%99%E0%B9%80%E0%B8%94%E0%B8%AD%E0%B8%A3%E0%B9%8C_%E0%B9%80%E0%B8%AE%E0%B8%A5%E0%B8%AA%E0%B9%8C%E0%B9%80%E0%B8%9A%E0%B8%B4%E0%B8%A3%E0%B9%8C%E0%B8%81&action=edit&redlink=1
https://th.wikipedia.org/wiki/%E0%B8%A0%E0%B8%B2%E0%B8%A9%E0%B8%B2%E0%B8%8B%E0%B8%B5%E0%B8%9E%E0%B8%A5%E0%B8%B1%E0%B8%AA%E0%B8%9E%E0%B8%A5%E0%B8%B1%E0%B8%AA
https://th.wikipedia.org/wiki/%E0%B8%A0%E0%B8%B2%E0%B8%A9%E0%B8%B2%E0%B9%80%E0%B8%94%E0%B8%A5%E0%B9%84%E0%B8%9F
https://th.wikipedia.org/wiki/%E0%B8%A0%E0%B8%B2%E0%B8%A9%E0%B8%B2%E0%B8%88%E0%B8%B2%E0%B8%A7%E0%B8%B2
https://th.wikipedia.org/wiki/%E0%B8%8B%E0%B8%AD%E0%B8%9F%E0%B8%95%E0%B9%8C%E0%B9%81%E0%B8%A7%E0%B8%A3%E0%B9%8C
https://th.wikipedia.org/wiki/%E0%B9%84%E0%B8%A1%E0%B9%82%E0%B8%84%E0%B8%A3%E0%B8%8B%E0%B8%AD%E0%B8%9F%E0%B8%97%E0%B9%8C
https://th.wikipedia.org/wiki/%E0%B8%A0%E0%B8%B2%E0%B8%A9%E0%B8%B2%E0%B8%94%E0%B8%AD%E0%B8%95%E0%B9%80%E0%B8%99%E0%B9%87%E0%B8%95
https://th.wikipedia.org/wiki/%E0%B8%A0%E0%B8%B2%E0%B8%A9%E0%B8%B2%E0%B8%94%E0%B8%AD%E0%B8%95%E0%B9%80%E0%B8%99%E0%B9%87%E0%B8%95
https://th.wikipedia.org/wiki/%E0%B9%84%E0%B8%A5%E0%B8%9A%E0%B8%A3%E0%B8%B2%E0%B8%A3%E0%B8%B5
https://th.wikipedia.org/wiki/%E0%B8%81%E0%B8%B2%E0%B8%A3%E0%B9%80%E0%B8%82%E0%B8%B5%E0%B8%A2%E0%B8%99%E0%B9%82%E0%B8%9B%E0%B8%A3%E0%B9%81%E0%B8%81%E0%B8%A3%E0%B8%A1
https://th.wikipedia.org/wiki/%E0%B8%AA%E0%B9%88%E0%B8%A7%E0%B8%99%E0%B8%95%E0%B9%88%E0%B8%AD%E0%B8%9B%E0%B8%A3%E0%B8%B0%E0%B8%AA%E0%B8%B2%E0%B8%99%E0%B8%81%E0%B8%B1%E0%B8%9A%E0%B8%9C%E0%B8%B9%E0%B9%89%E0%B9%83%E0%B8%8A%E0%B9%89
https://th.wikipedia.org/wiki/%E0%B8%AA%E0%B9%88%E0%B8%A7%E0%B8%99%E0%B8%95%E0%B9%88%E0%B8%AD%E0%B8%9B%E0%B8%A3%E0%B8%B0%E0%B8%AA%E0%B8%B2%E0%B8%99%E0%B8%81%E0%B8%B1%E0%B8%9A%E0%B8%9C%E0%B8%B9%E0%B9%89%E0%B9%83%E0%B8%8A%E0%B9%89
https://th.wikipedia.org/w/index.php?title=%E0%B8%81%E0%B8%B2%E0%B8%A3%E0%B9%80%E0%B8%8A%E0%B8%B7%E0%B9%88%E0%B8%AD%E0%B8%A1%E0%B8%95%E0%B9%88%E0%B8%AD%E0%B8%90%E0%B8%B2%E0%B8%99%E0%B8%82%E0%B9%89%E0%B8%AD%E0%B8%A1%E0%B8%B9%E0%B8%A5&action=edit&redlink=1
https://th.wikipedia.org/wiki/%E0%B8%A7%E0%B8%B4%E0%B8%97%E0%B8%A2%E0%B8%B2%E0%B8%81%E0%B8%B2%E0%B8%A3%E0%B9%80%E0%B8%82%E0%B9%89%E0%B8%B2%E0%B8%A3%E0%B8%AB%E0%B8%B1%E0%B8%AA%E0%B8%A5%E0%B8%B1%E0%B8%9A
https://th.wikipedia.org/wiki/%E0%B8%82%E0%B8%B1%E0%B9%89%E0%B8%99%E0%B8%95%E0%B8%AD%E0%B8%99%E0%B8%A7%E0%B8%B4%E0%B8%98%E0%B8%B5
https://th.wikipedia.org/wiki/%E0%B9%80%E0%B8%84%E0%B8%A3%E0%B8%B7%E0%B8%AD%E0%B8%82%E0%B9%88%E0%B8%B2%E0%B8%A2%E0%B8%84%E0%B8%AD%E0%B8%A1%E0%B8%9E%E0%B8%B4%E0%B8%A7%E0%B9%80%E0%B8%95%E0%B8%AD%E0%B8%A3%E0%B9%8C
https://th.wikipedia.org/wiki/%E0%B9%80%E0%B8%A7%E0%B9%87%E0%B8%9A%E0%B9%81%E0%B8%AD%E0%B8%9B%E0%B8%9E%E0%B8%A5%E0%B8%B4%E0%B9%80%E0%B8%84%E0%B8%8A%E0%B8%B1%E0%B8%99
https://th.wikipedia.org/wiki/%E0%B9%80%E0%B8%A7%E0%B9%87%E0%B8%9A%E0%B9%84%E0%B8%8B%E0%B8%95%E0%B9%8C
https://th.wikipedia.org/wiki/%E0%B9%80%E0%B8%A7%E0%B9%87%E0%B8%9A%E0%B9%81%E0%B8%AD%E0%B8%9B%E0%B8%9E%E0%B8%A5%E0%B8%B4%E0%B9%80%E0%B8%84%E0%B8%8A%E0%B8%B1%E0%B8%99
https://th.wikipedia.org/wiki/%E0%B9%80%E0%B8%A7%E0%B9%87%E0%B8%9A%E0%B9%80%E0%B8%8B%E0%B8%AD%E0%B8%A3%E0%B9%8C%E0%B8%A7%E0%B8%B4%E0%B8%8B
https://th.wikipedia.org/wiki/%E0%B8%94%E0%B8%AD%E0%B8%95%E0%B9%80%E0%B8%99%E0%B9%87%E0%B8%95%E0%B9%80%E0%B8%9F%E0%B8%A3%E0%B8%A1%E0%B9%80%E0%B8%A7%E0%B8%B4%E0%B8%A3%E0%B9%8C%E0%B8%81
https://th.wikipedia.org/wiki/%E0%B9%84%E0%B8%A1%E0%B9%82%E0%B8%84%E0%B8%A3%E0%B8%8B%E0%B8%AD%E0%B8%9F%E0%B8%97%E0%B9%8C


บทที ่3 

แผนงานการปฏิบัตงิานและขั้นตอนการด าเนินงาน 

 

3.1 แผนงานการปฏบิัติงาน 

 

 ตารางที ่3.1 แผนการปฏิบติังาน 

รายละเอยีดการปฏิบัติงาน 
ระยะเวลาการปฏิบัติงาน 

มิ.ย. 58 ก.ค. 58 ส.ค. 58 ก.ย. 58 
ศึกษาเคร่ืองท่ีใชใ้นการเขียนเวบ็ไซต ์                 
ออกแบบเวบ็ไซต ์                 
ท าเวบ็ไซตท่ี์สามารถรองรับไดท้ั้ง
คอมพิวเตอร์ สมาร์ทโฟน แทบ็เล็ต  

                

ตรวจสอบและแกไ้ขเวบ็ไซต ์                 
ศึกษาการท าคริสตลั รีพอร์ท                 
สร้างโครงหนา้ของรายงาน                 
เช่ือมขอ้มูลกบัรายงาน                 
ตรวจสอบและแกไ้ข คริสตลั รีพอร์ท                 
สรุปการท างาน                 
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ขั้นตอนการด าเนินงานของการออกรายงานดว้ย คริสตลั รีพอร์ท สามารถเขียนเป็นแผนการ

ท างานไดด้งัรูป 3.1 

 

 

 

รูปที ่3.1 ผงัการปฏิบติังานการออกรายงานดว้ย คริสตลั รีพอร์ท 
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ขั้นตอนการด าเนินงานของการออกแบบส่วนของผูใ้ชด้ว้ยบูทสแตรปสามารถเขียนเป็น

แผนการท างานไดด้งัรูป 3.2 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปที ่3.2 ผงัการปฏิบติังานการออกแบบส่วนของผูใ้ชง้านดว้ยบูทสแตรป 
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3.2 รายละเอยีดงานทีนั่กศึกษาปฏบิัติในงานสหกจิศึกษา หรือรายละเอยีดโครงงานที่

ได้รับมอบหมาย 

 3.2.1 ออกรายงานด้วย คริสตัล รีพอร์ท 

การออกรายงานดว้ย คริสตลั รีพอร์ท โดยการดึงขอ้มูลจากฐานขอ้มูลมาแสดง

ออกมาเป็นรายงานตามรูปแบบท่ีลูกคา้ตอ้งการ 

3.2.2 การออกแบบ ส่วนของผู้ใช้ ด้วย บูทสแตรป 

การออกแบบเวบ็ไซตด์ว้ยบูทสแตรป ท าใหเ้วบ็ไซตส์ามารถรองรับการใชง้านได้

ทั้งบนคอมพิวเตอร์ สมาร์ทโฟน และ แทบ็แล็ต 

  

3.3 ขั้นตอนการด าเนินงานทีนั่กศึกษาปฏบิัติงานหรือโครงงาน 

3.3.1 ออกรายงานด้วยคริสตัล รีพอร์ท 

1) ท าการติดตั้ง โปรแกรม ไมโครซอฟท ์วชิวล สตูดิโอ [1] 

2) หลงัจากท าการติดตั้งแลว้ ใหด้าวน์โหลด SAP จากเวบ็ไซต ์

http://scn.sap.com/docs/DOC-7824 แลว้ติดตั้ง [2] 

3) เม่ือติดตั้งเสร็จแลว้ใหเ้ปิดโปรแกรมข้ึนมาเพื่อเร่ิมการท างานดงัรูปท่ี 3.3 

 

รูปที ่3.3 หนา้ต่างการแสดงการเขา้โปรแกรม 

http://scn.sap.com/docs/DOC-7824
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4) การสร้างงานใหม่มีขั้นตอนดงัน้ี 

♠ สร้างงานใหม่ข้ึนมา โดยกดท่ี New Project ดงัรูปท่ี 3.4 หรือ ไปท่ี File > New > 

Project ดงัรูปท่ี 3.5 จากนั้นใหเ้ลือก Web > ASP.NET MVC4 Web Application > ตั้งช่ือ

งาน > กด OK ดงัรูป 3.6 

 

รูปที ่3.4 การสร้างงานแบบท่ี 1 

 

 

รูปที ่3.5 การสร้างงานแบบท่ี 2 
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รูปที ่3.6 หนา้ต่าง New Project 

 

♠ จากนั้นจะไดห้นา้ต่างตั้งค่า Template ใหเ้ลือก Internet Application แลว้กด OK 

ดงัรูปท่ี 3.7 

 

รูปที ่3.7 หนา้ต่าง New ASP.NET MVC 4 Project 
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♠ จากนั้นจะไดห้นา้ต่างพร้อมใชง้าน ดงัรูปท่ี 3.8 

 

รูปที ่3.8 หนา้จอโปรแกรมพร้อมใชง้าน 

 

5) หลงัจากสร้างงานใหม่แลว้ ต่อไปสร้างรายงานมีขั้นตอนดงัน้ี 

♠ ดา้นขวามือจะมีแถบ Solution Explorer ใหค้ลิกขวาท่ีช่ืองานของเรา > Add > 

New Folder เพื่อสร้างแฟ้มงานใหม่ แลว้ตั้งช่ือวา่ Report ดงัรูปท่ี 3.9 - 3.10 

 

รูปที ่3.9 การสร้างแฟ้มงานใหม่ 
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รูปที ่3.10 การตั้งช่ือแฟ้มงาน 

 

♠ จากนั้นท าการสร้าง คริสตลั รีพอร์ท โดยคลิกขวาท่ี Report > Add > New Item 

ดงัรูปท่ี 3.11 คลิกท่ี New Item จะมีหนา้ต่าง Add New Item ข้ึนมาเลือก Reporting > Crystal 

Reports > ตั้งช่ือรายงาน > กด Add ดงัรูป 3.12 จากนั้นจะข้ึนหนา้ต่างรูปแบบของรายงาน

ใหเ้ลือก Standard แลว้กด OK ดงัรูป 3.13 เม่ือกด OK แลว้จะมีหนา้ต่างตั้งค่าฐานขอ้มูลให้

ขา้มไปก่อนโดยการกด Finish ดงัรูป 3.14 จะไดห้นา้ต่างการสร้างรีพอร์ท ดงัรูป 3.15 

 

รูปที ่3.11 การสร้าง New Item 
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รูปที ่3.12 หนา้ต่าง Add New Item 

 

 

รูปที ่3.13 หนา้ต่าง Crystal Report Gallery 
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รูปที ่3.14 หนา้ต่าง Standard Report Creation Wizard 

 

 

รูปที ่3.15 หนา้จอโปรแกรมพร้อมท ารายงาน 
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6) หลงัจากไดห้นา้จอท ารายงานแลว้ ใหส้ร้างรายงานตามแบบท่ีลูกคา้ใหม้า 

 ♠ การพิมพข์อ้ความ  

♥ คลิกขวา เลือก Insert > Text Object ดงัรูป 3.16 จากนั้นจะข้ึนกล่องให้

พิมพข์อ้ความดงัรูป 3.17 

 

รูปที ่3.16 การเปิดกล่องพิมพข์อ้ความ 

 

 

รูปที ่3.17 กล่องพิมพข์อ้ความ 



21 
 

 ♠ การสร้างเส้น  

♥ คลิกขวา เลือก Insert > Line ดงัรูป 3.18 จากนั้นก็ลากลงบนท่ีวา่งก็จะ

ไดเ้ส้นตรง สามารถเล่ือนหรือปรับขนาดไดท่ี้หลงั 

 

รูปที ่3.18 การสร้างเส้น 

 

 ♠ การสร้างกล่อง 

♥ คลิกขวา เลือก Insert > Box ดงัรูป 3.19 จากนั้นก็ลากลงบนท่ีวา่งก็จะ

ไดก้ล่อง สามารถเล่ือนหรือปรับขนาดไดท่ี้หลงั 

 

รูปที ่3.19 การสร้างกล่อง 
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♠ การใส่ภาพ 

♥ คลิกขวา เลือก Insert > Picture ดงัรูป 3.20 แลว้จะไดรู้ปมาไวใ้นงาน 

 

รูปที ่3.20 การใส่ภาพ 

 

♠ การแต่ง การใส่สี 

 ♥ หลงัจากพิมพข์อ้ความแลว้ ขั้นตอนต่อไปคือการแต่งขอ้ความ โดยให้

คลิกท่ีกล่องขอ้ความ จากนั้นคลิกขวา เลือก Format Object ดงัรูป 3.21 จากนั้นจะ

ข้ึนหนา้ต่างแต่งภาพมาเราสามารถแต่งภาพไดต้ามท่ีเราตอ้งการแลว้กด OK ดงัรูป 

3.22 

 

รูปที ่3.21 การเขา้หนา้ต่างแต่งขอ้ความ 
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รูปที ่3.22 หนา้ต่าง Format Editor 

 

7) หลงัจากสร้างรายงานเสร็จ เราสามารถดูตวัอยา่งรายงานไดโ้ดยการกด Main Report 

Preview ดงัรูป 3.23 จะแสดงตวัอยา่งรายงาน ดงัรูป 3.24 

 

รูปที ่3.23 การดูรายงานตวัอยา่ง 
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รูปที ่3.24 รายงานตวัอยา่ง 

 

8) การ Run ดูรายงานบนเวบ็ไซต ์

♠ ไปท่ี Controller > HomeController พิมพโ์คด้การดึง คริสตลั รีพอร์ท เป็นไฟล ์

PDF ดงัรูป 3.25 

 

รูปที ่3.25 โคด้การดึงขอ้มูลเป็นไฟล ์PDF 
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♠ จากนั้น ไปท่ี View > Home > Index.cshtml ใส่โคด้ดงัรูป 3.26 เพื่อเป็นลิงคใ์น

การกดโหลด ไฟล ์PDF 

 

รูปที ่3.26 โคด้การใส่ลิงคเ์พื่อโหลดไฟล ์PDF 

 

9) หลงัจากสร้างโครงรายงานเสร็จแลว้ ขั้นตอนต่อไปคือการใส่ขอ้มูลจากฐานขอ้มูลลงไป

ในรายงาน 

♠ ก่อนจะ เ ร่ิมต้นการจัดการฐานข้อ มูลจะต้อง มี โปรแกรม  SQL Server 

Management ถา้ไม่มีให้ดาวน์โหลดและติดตั้งลงเคร่ือง เม่ือท าการติดตั้งเสร็จแลว้ให้เปิด

โปรแกรม SQL Server Management ข้ึนมาดงัรูป 3.27 
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รูปที ่3.27 หนา้จอโปรแกรม SQL Server Management 

 

♠ หลงัจากเปิดโปรแกรมข้ึนมาแลว้ใหส้ร้างฐานขอ้มูลโดยการ คลิกขวาท่ี 

Database > New Database ดงัรูป 3.28 

 

รูปที ่3.28 การสร้างฐานขอ้มูลใหม่ 
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♠ จากนั้นจะมีหนา้ต่าง New Database ข้ึนมาใหต้ั้งช่ือฐานขอ้มูลแลว้กด OK ดงัรูป 

3.29 จากนั้นจะไดฐ้านขอ้มูลตามช่ือท่ีเราสร้างดงัรูป 3.30 

 

รูปที ่3.29 หนา้ต่าง New Database 

 

 

รูปที ่3.30 สร้างฐานขอ้มูลใหม่ 
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♠ จากนั้นคลิกขวาท่ีช่ือฐานขอ้มูลท่ีเราสร้าง เลือก New Query ดงัรูป 3.31 

 

รูปที ่3.31 New Query 

 

♠ จากนั้นจะข้ึนหนา้ต่าง Query มาดงัรูป 3.32 จากนั้นให้เราลากไฟล ์SQL ลงมา

ในหนา้ต่าง Query ก็จะไดฐ้านขอ้มูลมาเป็นอนัเสร็จ  

 

รูปที ่3.32 หนา้ต่าง Query 
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♠ จากนั้นเช่ือมต่อฐานขอ้มูลกบัโปรแกรม โดยคลิกขวาท่ีช่ืองาน > Add > New 

Item ดงัรูป 3.33  

 

รูปที ่3.33 การเช่ือมต่อฐานขอ้มูล 

 

♠ จากนั้นจะไดห้นา้ต่าง Add New Item ข้ึนมาดงัรูป 3.34 ใหเ้ลือก Data > 

ADO.NET Entity Data Model > ตั้งช่ือ Model > add  

 

รูปที ่3.34 หนา้ต่าง Add New Item 
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♠ จากนั้นจะข้ึนหนา้ต่าง Entity Data Model Wizard เลือก Generate from database 

> Next ดงัรูป 3.35 จากนั้นใหต้ั้งค่าฐานขอ้มูล กด New Connection ดงัรูป 3.36 

 

รูปที ่3.35 หนา้ต่าง Entity Data Model Wizard 

 

 

รูปที ่3.36 ปุ่ม New Connection 
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♠ จากนั้นจะไดห้นา้ต่าง Connection Properties ใหต้ั้งค่าฐานขอ้มูลใหเ้รียบร้อย

แลว้กด OK และ Next ดงัรูป 3.37-3.38 

 

รูปที ่3.37 หนา้ต่าง Connection Properties 

 

 

รูปที ่3.38 ตั้งค่าฐานขอ้มูลเรียบร้อย 
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 ♠ จากนั้นจะไดด้งัรูป 3.39 เลือก Table แลว้กด Finish จะไดด้งัรูป 3.40 

 

รูปที ่3.39 เลือกตารางขอ้มูล 

 

 

รูปที ่3.40 รูปโครงสร้างฐานขอ้มูล 
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♠ ไปท่ีรายงาน คลิกขวาท่ี Database Fields > Database Expert ดงัรูป 3.41จากนั้น

จะได้หน้าต่าง Database Expert ดงัรูป 3.42 จากนั้นให้เลือกขอ้มูลตารางฐานข้อมูลท่ีเรา

ตอ้งการใชแ้ลว้กด OK ดงัรูป 3.43 

 

รูปที ่3.41 เลือก Database Expert 

 

 

รูปที ่3.42 หนา้ต่าง Database Expert 
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รูปที ่3.43 การเลือกตารางฐานขอ้มูล 

 

♠ จากนั้ น ให้ไปเขียนโค้ด Query ฐานข้อมูลท่ีต้องใช้ในรายงานออกมา ท่ี 

HomeController ดงัรูป 3.44 

 

รูปที ่3.44 โคด้ Query ฐานขอ้มูล 
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♠ จากนั้นไปท่ีรายงานแลว้คลิกลากช่ือขอ้มูลมาไวใ้นท่ีๆเราตอ้งการ ดงัรูป 3.45 

เราสามารถตรวจสอบวา่ขอ้มูลเขา้หรือไม่ โดยการกด Main Report Preview ดงัรูป 3.46 

 

รูปที ่3.45 การใส่ขอ้มูล 

 

 

รูปที ่3.46 การดูตวัอยา่งรายงาน 
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10) การท า Check Box  

♠ เลือก Formula Fields > New ดงัรูป 3.47 จากนั้นหนา้ต่าง Formula Name ข้ึนมา

ใหต้ั้งช่ือค่านั้นๆ ดงัรูป 3.48 

 

รูปที ่3.47 การสร้างค่าใหก้บัขอ้มูล 

 

 

รูปที ่3.48 หนา้ต่าง Formula Name 
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♠ หลังจาดตั้ ง ช่ือ เส ร็จจะมีหน้า ต่าง  Formula Workshop ปรากฏข้ึนมา  ให้

ก าหนดค่าตามความตอ้งการเช่น ถ้าค่าเป็น True ให้มีเคร่ืองหมายถูกข้ึนถา้เป็น false ให้

เป็นกล่องส่ีเหล่ียมเปล่าๆ หลงัจากก าหนดเสร็จใหก้ด Save and Close ดงัรูป 3.49 

 

รูปที ่3.49 หนา้ต่าง Formula Workshop 

 

♠ จากนั้นใหก้ าหนด Font ตวัอกัษรเป็น Wingdings และก าหนดขนาด สีตวัอกัษร

ตามตอ้งการ แลว้กด OK ดงัรูป 3.50 ก็เป็นอนัเสร็จ 

 

รูปที ่3.50 การก าหนดรูปแบบตวัอกัษร 
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3.3.2 การออกแบบ ส่วนของผู้ใช้งาน ด้วย บูทสแตรป 

1) รับความตอ้งการจากลูกคา้ จากความตอ้งการของลูกคา้ ลูกคา้ตอ้งการท าเวบ็ไซต์หน้า

เดียว และสามารถแสดงผลได้ทั้งหน้าจอคอมพิวเตอร์ สมาร์ทโฟน และแท็บเล็ต ซ่ึงทางผูจ้ดัท า

เลือกใชบู้ทสแตรป ซ่ึงเป็นเคร่ืองมือหน่ึงในการออกแบบเวบ็ไซตม์าใชใ้นงานช้ินน้ี เน่ืองจากบูทส

แตรปมีความสามารถท าให้เวบ็ไซต์แสดงผลได้บนคอมพิวเตอร์ สมาร์ทโฟน และแท็บเล็ต และ

สามารถเรียกใชไ้ดไ้ม่ยาก 

2) รับแบบเวบ็ไซตจ์อขนาดคอมพิวเตอร์ และแท็บเล็ตมาจากลูกคา้ ซ่ึงลูกคา้ไดใ้ห้ตวัอยา่ง

หนา้จอเวบ็ท่ีแสดงบนคอมพิวเตอร์มาให้ดงัรูป 3.51 - 3.53 

 

 

รูปที ่3.51 ตวัอยา่งเวบ็ไซตข์นาดหนา้จอคอมพิวเตอร์ 1 
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รูปที ่3.52 ตวัอยา่งเวบ็ไซตข์นาดหนา้จอคอมพิวเตอร์ 2 

 

 

รูปที ่3.53 ตวัอยา่งเวบ็ไซตข์นาดหนา้จอคอมพิวเตอร์ 3 
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3) เสนอแบบเวบ็ไซตห์นา้จอส าหรับสมาร์ทโฟนใหก้บัลูกคา้ และท าการแกไ้ขแบบจนกวา่

ลูกคา้จะพึงพอใจ โดยแบบท่ีผูจ้ดัท าไดอ้อกแบบเป็นดงัรูป 3.54 - 3.56 

 

รูปที ่3.54 ตวัอยา่งเวบ็ไซตข์นาดหนา้จอสมาร์ทโฟน และแทบ็เล็ต 1 
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รูปที ่3.55 ตวัอยา่งเวบ็ไซตข์นาดหนา้จอสมาร์ทโฟน และแทบ็เล็ต 2 
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รูปที ่3.56 ตวัอยา่งเวบ็ไซตข์นาดหนา้จอสมาร์ทโฟน และแทบ็เล็ต 3 
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4) ลงมือเขียนเวบ็ไซตใ์หห้นา้ตาเหมือนกบัท่ีลูกคา้ไดใ้หต้วัอยา่งเวบ็ไซตข์นาดหนา้

จอคอมพิวเตอร์ และแบบท่ีผูจ้ดัท าไดอ้อกแบบขนาดหนา้จอสมาร์ทโฟน และแทบ็เล็ต 

4.1) เวบ็ไซตข์นาดหนา้จอคอมพิวเตอร์ 

♠ ส่วน Header ของเวบ็ไซต ์ดงัรูป 3.57 

 

รูปที ่3.57 ส่วน Header 

 

  ♠ ส่วน Menu Bar ของเวบ็ไซต ์ดงัรูป 3.58 

 

รูปที ่3.58 ส่วน Menu Bar 

 

  ♠ ส่วนของเน้ือหาของเวบ็ไซต ์ดงัรูป 3.59 

 

รูปที ่3.59 ส่วนของเน้ือหา 
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  ♠ เม่ือเล่ือนลงมา Menu Bar จะปรากฏโลโกข้ึ้นมา ดงัรูป 3.60 

 

รูปที ่3.60 โลโกป้รากฏข้ึนบน Menu Bar 

 

 ♠ ส่วน Footer ของเวบ็ไซต ์ดงัรูป 3.61 

 

รูปที ่3.61 ส่วน Footer 
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4.2) เวบ็ไซตข์นาดหนา้จอสมาร์ทโฟน และแทบ็เล็ต 

 ♠ ส่วน Header ของเวบ็ไซต ์ดงัรูป 3.62 

 

รูปที ่3.62 ส่วน Header 

 

♠ ส่วน Menu bar ของเว็บไซต์ ดงัรูป 3.63 ในส่วนน้ีจะมี  เป็นวิธีการท า 

แฮมเบอร์เกอร์ Menu เวลาหนา้จอเล็กลงพอกดแลว้จะไดด้งัรูป 3.64 

 

รูปที ่3.63 ส่วน Menu Bar 

 

 

รูปที ่3.64 การแฮมเบอร์เกอร์ Menu 
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 ♠ ส่วนของเน้ือหาของเวบ็ไซต ์ดงัรูป 3.65 

 

รูปที ่3.65 ส่วนเน้ือหา 

 

 ♠ เม่ือเล่ือนลงมา Menu Bar จะปรากฏโลโกข้ึ้นมา ดงัรูป 3.66 - 3.67 

 

รูปที ่3.66 โลโกป้รากฏข้ึนบน Menu Bar 
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รูปที ่3.67 โลโกป้รากฏข้ึนบน Menu Bar และการแฮมเบอร์เกอร์ Menu 

 

♠ ส่วน Footer ของเวบ็ไซต ์ดงัรูป 3.68 

 

รูปที ่3.68 ส่วน Footer 

 

 

  

  

 



บทที ่4 

ผลการด าเนินงาน   

 

4.1 ขั้นตอนและผลการด าเนินงาน 

 4.1.1 การออกรายงานด้วย คริสตัล รีพอร์ท 

การออกรายงานดว้ย คริสตลั รีพอร์ท จะเป็นการเปิดหน้าของเวบ็ไซต์ข้ึนมา กด
ดาวน์โหลด เพื่อออกรายงานเป็น PDF โดยการจะดึงขอ้มูลข้ึนมาแสดง มาจากฐานขอ้มูล
เพื่อท่ีจะแสดงในรายงาน 

1) การออกรายงานดว้ย คริสตลั รีพอร์ท  

♠ กดปุ่ม Run โปรแกรมก็จะเวบ็ไซตใ์นการดาวน์โหลดรายงานข้ึนมาไดด้งัรูป 4.1 

 

 

รูปที ่4.1 หนา้ตาเวบ็ไซต ์
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♠ หลงัจากไดห้นา้ต่างของเวบ็ไซตข้ึ์นมาแลว้ใหก้ดเลือก รายงานท่ีตอ้งการจะ
ดาวน์โหลดดงัรูปท่ี 4.2 

 

รูปที ่4.2 ดาวน์โหลดรายงาน 

 

♠ หลงัจากดาวน์โหลดแลว้ ใหก้ดไฟล ์PDF ข้ึนมาจะไดด้งัรูป 4.3 ถา้ใส่ขอ้มูลก็จะ
เป็นดงัรูป 4.4 

 

รูปที ่4.3 ไฟลร์ายงานเป็น PDF 
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รูปที ่4.4 ไฟลร์ายงานมีขอ้มูล 

  

2) ผลการประเมินงานการออกรายงานดว้ย คริสตลั รีพอร์ท จากลูกคา้ 

  ♠ ท าแบบรายงานออกมาไดเ้หมือนกบัตวัอยา่งรายงานมาก 

  ♠ ท างานไดเ้รียบร้อย เก็บรายละเอียดงานไดดี้ 

  ♠ ดึงขอ้มูลจากฐานขอ้มูลไดถู้กตอ้ง 

  ♠ พิมพผ์ดิ ตกหล่นบา้งเล็กนอ้ย 
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4.1.2 การออกแบบส่วนของผู้ใช้งานด้วย บูทสแตรป 

การออกแบบส่วนของผูใ้ชง้านดว้ย บูทสแตรป เป็นการออกแบบเวบ็ไซตโ์ดยการ
ใช้บูทสแตรปเป็นตวัช่วยในการเขียน เพื่อเพิ่มประสิทธิภาพในการท างาน โดยการเขียน
เว็บด้วยบูทสแตรปจะสามารถรองรับหน้าจอได้หลายขนาดไม่ว่าจะเป็น หน้าจอ
คอมพิวเตอร์ หนา้จอสมาร์ทโฟน หนา้จอแทบ็เล็ต 

1) การเปิดเวบ็ไซตบ์นจอสมาร์ทโฟน และแทบ็เล็ต 

♠ ติดตั้งโปรแกรม Xampp [3] 

♠ เอาแฟ้มงานเวบ็ไซตเ์อาไวใ้น Xampp > htdocs 

♠ เปิดโปรแกรม Xampp Control Panel ข้ึนมาดงัรูป 4.5 

 

รูปที ่4.5 หนา้ต่างโปรแกรม Xampp Control Panel  
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♠ หลงัจากเปิดโปรแกรม Xampp Control Panel แลว้ใหก้ดปุ่ม Start ตรง Apache
ดงัรูป 4.6 จะไดด้งัรูป 4.7 

 

รูปที ่4.6 ปุ่ม Start ตรง Apache 

 

 

รูปที ่4.7 หลงัจาก กดปุ่ม Start 
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♠ จากนั้นใหเ้ปิด Command Prompt ข้ึนมา ดงัรูป 4.8 

 

รูปที ่4.8 หนา้ต่าง Command Prompt 

 

♠ จากนั้นใหพ้ิมพ ์ipconfig แลว้กด Enter จากนั้นใหห้า IPv4 Address ดงัรูป 4.9
เอา IP มาใชง้านการ Run เวบ็ไซต ์โดยใส่ IP/ช่ือแฟ้มงาน 

 

รูปที ่4.9 IPv4 Address 
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2) ผลงานการออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรป 

♠ สมาร์ทโฟน 

     

รูปที ่4.10 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอสมาร์ทโฟน 1 

 

     

รูปที ่4.11 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอสมาร์ทโฟน 2 
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รูปที ่4.12 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอสมาร์ทโฟน 3 

 

     

รูปที ่4.13 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอสมาร์ทโฟน 4 
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♠ แทบ็เล็ต แนวตั้ง 

 

รูปที ่4.14 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอแทบ็เล็ต 1 

 

รูปที ่4.15 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอแทบ็เล็ต 2 
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รูปที ่4.16 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอแทบ็เล็ต 3 

 

 

รูปที ่4.17 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอแทบ็เล็ต 4 
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รูปที ่4.18 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอแทบ็เล็ต 5 

 

 

รูปที ่4.19 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอแทบ็เล็ต 6 
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รูปที ่4.20 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอแทบ็เล็ต 7 

 

 
รูปที ่4.21 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอแทบ็เล็ต 8 
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♠ แทบ็เล็ต แนวนอน 

 
รูปที ่4.22 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอแทบ็เล็ต 9 

 

 
รูปที ่4.23 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอแทบ็เล็ต 10 
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รูปที ่4.24 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอแทบ็เล็ต 11 

 

 

รูปที ่4.25 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอแทบ็เล็ต 12 
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รูปที ่4.26 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอแทบ็เล็ต 13 

 

 
รูปที ่4.27 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอแทบ็เล็ต 14 
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รูปที ่4.28 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอแทบ็เล็ต 15 

 

 
รูปที ่4.29 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอแทบ็เล็ต 16 
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♠ หนา้จอคอมพิวเตอร์ 

 

รูปที ่4.30 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอคอมพิวเตอร์ 1 

 

 

รูปที ่4.31 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอคอมพิวเตอร์ 2 

 

 

 



65 
 

 

รูปที ่4.32 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอคอมพิวเตอร์ 3 

 

 

รูปที ่4.33 งานออกแบบส่วนของผูใ้ชง้าน ดว้ยบูทสแตรปหนา้จอคอมพิวเตอร์ 4 
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2) ผลการประเมินงานการออกแบบส่วนของผูใ้ชง้านดว้ย บูทสแตรป 

♠ ท าแบบรายงานออกมาไดเ้หมือนกบัตวัอยา่งรายงานมาก 

  ♠ ท างานไดเ้รียบร้อย เก็บรายละเอียดงานไดดี้ 

  ♠ ส่วนงานท่ีออกแบบเองออกแบบไดส้วยดี 

  ♠ เวบ็สวยใชง้านไดง่้าย 

  ♠ ตอ้งแกข้นาดของรูปบางรูปใหญ่ หรือเล็กเกินไป 

  ♠ ตอ้งแกต้วัหนงัสือโดยใชแ้บบตวัอกัษร และขนาดใหม้นัอ่านง่ายมากยิง่ข้ึน 

 

4.2 ผลการวเิคราะห์ข้อมูล 

 จากการวิเคราะห์ขอ้มูลจากการด าเนินงาน ไม่ว่าจะเป็นงานในส่วนของการออกรายงาน
ดว้ย คริสตลั รีพอร์ท และการออกแบบส่วนของผูใ้ชง้านดว้ย บูทสแตรป ไดพ้บทั้งขอ้ดี และขอ้เสีย
ในการใช้งาน โดยจะเปรียบเทียบการออกรายงานแบบเอกสารแบบเก่า กบั การออกรายงานด้วย 
คริสตลั รีพอร์ท และการเปรียบเทียบการออกแบบส่วนของผูใ้ชง้านโดยไม่ใชบู้ทสแตรป กบั การ
ออกแบบส่วนของผูใ้ชง้านโดยใชบู้ทสแตรป ดงัต่อไปน้ี 

 

4.2.1 การเปรียบเทียบการออกรายงานแบบเอกสาร แบบเก่า กับ การออกรายงานด้วย คริสตัล  
รีพอร์ท แบบใหม่ 

 การออกรายงานแบบเอกสาร  

ข้อดี  

♠ มีความปลอดภยัในการรักษาความลบัของขอ้มูล 

ข้อเสีย  

♠ เวลาเก็บขอ้มูลเอกสารจะเยอะมากอาจจะเกิดการสูญหายได ้

  ♠ เอกสารอาจจะเกิดการช ารุดไดง่้าย 
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  ♠ เม่ือเอกสารเกิดการสูญหายไม่สามารถกูข้อ้มูลกลบัคืนมาได ้

 การออกรายงานด้วย คริสตัล รีพอร์ท 

 ข้อดี  

♠ มีความสะดวกต่อผูใ้ชง้าน 

  ♠ สามารถเก็บขอ้มูลไดง่้าย ไวใ้นฐานขอ้มูล 

  ♠ สามารถส ารองขอ้มูลของลูกคา้ไวไ้ด ้เพื่อป้องกนัการสูญหาย 

 ข้อเสีย  

♠ อาจจะใชง้านยากส าหรับคนท่ีใชเ้ทคโนโลยไีม่เป็น 

  ♠ เส่ียงต่อการถูกเจาะระบบ  

 

4.2.2 การเปรียบเทียบการออกแบบส่วนของผู้ใช้งานโดยไม่ใช้บูทสแตรป กับ การออกแบบส่วน      
ของผู้ใช้งานโดยใช้บูทสแตรป 

 การออกแบบส่วนของผู้ใช้งานโดยไม่ใช้บูทสแตรป 

 ข้อดี  

  ♠ สามารถเขียน ปรับแต่งไดเ้องตามความตอ้งการ 

  ♠ เหมาะส าหรับงานท่ีไม่เร่งรีบ 

 ข้อเสีย  

  ♠ ใชร้ะยะเวลาในการท างาน 

♠ ช่องทางในการเข้าถึงน้อยเน่ืองจากเข้าชมเว็บไซต์ได้ผ่านทางคอมพิวเตอร์
เท่านั้น 

  ♠ จะตอ้งก าหนดรูปแบบเองทั้งหมด 
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 การออกแบบส่วนของผู้ใช้งานโดยใช้บูทสแตรป 

 ข้อดี  

  ♠ สามารถลดระยะเวลาในการท างาน 

  ♠ มีรูปแบบเวบ็ไซตแ์บบส าเร็จรูปมาใหเ้ป็นตน้แบบ 

 ♠ ช่องทางในการเข้าถึงมีมากสามารถเข้าชมเว็บไซต์ได้ผ่านทางคอมพิวเตอร์ 
สมาร์ทโฟน และแทบ็เล็ต 

 ข้อเสีย  

  ♠ ตอ้งศึกษาวธีิการใชง้าน 

  ♠ ช่วงเร่ิมแรกอาจจะใชง้านยาก 

 

4.3 วเิคราะห์และวจิารณ์ข้อมูลโดยเปรียบเทยีบผลทีไ่ด้รับกบักบัวตัถุประสงค์และ
จุดมุ่งหมายในการปฏบัิตงิานหรือการจัดท าโครงการ 

 จากการด าเนินงานท่ีผา่นมา ไดมี้การน าไปใชจ้ริง สามารถเพิ่มประสิทธิภาพในการท างาน 
และสามารถลดปัญหาในการปฏิบติังานได้ และสามารถตอบสนองความตอ้งการตามวตัถุประสงค์
ไดเ้ป็นอยา่งดีดงัน้ี 

ตารางที ่4.1 ตารางเปรียบเทียบจุดประสงค ์และผลท่ีไดรั้บของการออกรายงานดว้ย คริสตลั รีพอร์ท 

วตัถุประสงค์ ผลทีไ่ด้ 

1) สามารถลดระยะเวลาในการท างานได้เป็น
อยา่งดี 

คริสตลั รีพอร์ท สามารถลดเวลาในการท างาน
ไดจ้ริง 

2) สามารถเพิ่มความสะดวกสบายใหก้บัผูง้าน 
คริสตัล รีพอร์ท สามารถเพิ่มความสะดวก 
สบายให้กับผู ้ใช้งานโดยออกรายงานผ่าน
เวบ็ไซต ์เซฟไฟลเ์ป็น PDF 

3) สามารถเปล่ียนจากการท างานเอกสารดว้ย
การเขียนเป็นการพิมพด์ว้ยคอมพิวเตอร์ 

คริสตลั รีพอร์ท ท าให้ผูใ้ช้งานเปล่ียนจากการ
เขียนมาเป็นการพิมพ ์โดยการกรอกขอ้มูลผา่น
เวบ็ไซต ์
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ตารางที่ 4.2 ตารางเปรียบเทียบจุดประสงค์ และผลท่ีได้รับของออกแบบส่วนของผูใ้ช้งานด้วย  
บูทสแตรป 

วตัถุประสงค์ ผลทีไ่ด้ 

1) สามารถเพิ่มประสิทธิภาพในการพัฒนา
เวบ็ไซต ์

บูทสแตรป เป็นเคร่ืองมือในการช่วยให้มี
ประสิทธิภาพในการเขียนเวบ็ไซตม์ากข้ึน 

2) สามารถท าให้ส่วนของผูใ้ช้รองรับการใช้
งานผา่นทาง สมาร์ทโฟน แทบ็เล็ตได ้

บูทสแตรป สามารถรองรับการใชง้านไม่ว่าจะ
เป็นคอมพิวเตอร์ สมาร์ทโฟน และแทบ็เล็ต 

3) สามารถลดระยะเวลาในการท างานได้อย่าง
ดี 

บูทสแตรปสามารถลดระยะเวลาในการท างาน
ไดดี้ 

 



บทที ่5 

บทสรุปและข้อเสนอแนะ 

 

5.1 สรุปผลการด าเนินงาน 

 จากท่ีได้ปฏิบติังานสหกิจศึกษาเป็นระยะเวลา 4 เดือน ณ ท่ีบริษทั ดิจิโอ (ประเทศไทย) 
จ ากัด ข้าพเจ้ารู้สึกประทับใจ ท่ีได้รับความรู้ และประสบการณ์อีกมากมายจาก บริษทั ดิจิโอ 
(ประเทศไทย) จ ากดัแห่งน้ี ไม่วา่จะเป็นดา้นความรู้ ความสามารถในการท างานท่ีเพิ่มมากข้ึน ดา้น
ของการวางตวัในท่ีท างาน การพูดคุยกบัผูใ้หญ่ การออกแบบ และน าเสนองาน เป็นตน้ ในเดือนแรก
ท่ีขา้พเจา้ไดม้าปฏิบติังาน งานแรกท่ีขา้พเจา้ได้รับมอบหมายมาท า คือการเขียน CSS ใบเสร็จใหก้บั
เคร่ืองปร้ินใบเสร็จของบริษทั โดยเขียน CSS ตามแบบท่ีพี่นกัออกแบบไดอ้อกแบบไว ้ขา้พเจา้รู้สึก
ต่ืนเตน้ และรู้สึกภูมิใจมากท่ีไดรั้บงานท่ีเป็นงานของบริษทัจริง ๆ และไดรั้บค าชมจากงานช้ินน้ีว่า 
ท างานไดดี้ เรียบร้อยเหมือนแบบท่ีพี่นกัออกแบบ ออกแบบมาก เก็บรายละเอียดไดดี้ หลงัจากงาน
ช้ินแรกขา้พเจา้ก็ไดรั้บความไวว้างใจในการท างานมากข้ึน และไดม้อบหมายงานทางดา้นต่างๆ เช่น 
การเขียนและออกแบบเวบ็ไซต์ แพ็คของ พบักล่องบรรจุภณัฑ์ ท าเวบ็ไซต์ท่ีเป็นคู่มือการใช้งาน
อุปกรณ์การช าระเงินผา่นสมาร์ทโฟน และแทบ็เล็ตส าหรับการเปิดใชง้านบนสมาร์ทโฟน และแทบ็
เล็ต ท าเวบ็ไซตห์ลงับา้น ตรวจสอบอุปกรณ์การช าระเงินผา่นสมาร์ทโฟน และแทบ็เล็ต ท าการออก
รายงานดว้ย คริสตลั รีพอร์ท เป็นตน้  

ส่ิงเหล่าน้ีลว้นเป็นความรู้ และประสบการณ์ท่ีไดจ้ากการท างานคร้ังน้ีของขา้พเจา้ ขา้พเจา้
ไดเ้รียนรู้การเขียน CSS ท่ีถูกตอ้งจากการสอนจากพี่เล้ียง รู้จกัการน าบูทสแตรปมาช่วยในการเขียน 
และออกแบบเวบ็ไซต ์โดยบูทสแตรปเป็นตวัช่วยใหเ้ขียนเวบ็ไดง่้าย และรวดเร็วมากยิง่ข้ึน  ขา้พเจา้
ไดมี้โอกาสไดล้องเขียน Node.js ให้กบัเวบ็ไซตข์องบริษทัหลกัทรัพยแ์ห่งหน่ึง ซ่ึงเป็นความรู้ และ
ประสบการณ์ใหม่ท่ีขา้พเจา้ตอ้งใช้เวลาในการศึกษาหาความรู้ วิธีการใช้งาน และวิธีการเขียน ได้
เรียนรู้การใช้โปรแกรมไมโครซอฟท์ วิชวล สตูดิโอ ซ่ึงขา้พเจา้ไดน้ ามาใช้ในเขียนภาษา C# และ 
.NET ในการเขียนโคด้ออกรายงานด้วย คริสตลั รีพอร์ท ได้เรียนรู้การออกรายงานด้วย คริสตลั  
รีพอร์ท และไดเ้รียนรู้การดึงขอ้มูลจากฐานขอ้มูลมาใช้แสดงในรายงาน ผลการท างานท่ีออกมาแต่
ละช้ินนั้นเป็นท่ีพึ่งพอใจของพี่เล้ียง และเป็นท่ีภาคภูมิใจของขา้พเจา้ เน่ืองจากผลงานแต่ละช้ิน
ขา้พเจา้ไดพ้ยายามเรียนรู้ ฝึกฝน และตั้งใจท างาน ไม่วา่จะเจอปัญหา และอุปสรรคมากมาย ขา้พเจา้
ก็สามารถท างานไดส้ าเร็จลุล่วงไปดว้ยดีโดยสามารถตอบวตัถุประสงคใ์นการท างานของขา้พเจา้ได ้
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5.2 ปัญหาทีพ่บ และแนวทางแก้ไข 

ปัญหาท่ีพบในระหวา่งการปฏิบติังานมีดงัน้ี 

1) ขา้พเจา้ไม่มีความรู้ และประสบการณ์ทางด้านการเขียนเว็บ การเขียนภาษา C# .NET 
และการท าคริสตลั รีพอร์ทเลย 

2) คอมพิวเตอร์แรมไม่พอในการท างาน คอมพิวเตอร์คา้งบ่อย ท าให้เกิดความล่าชา้ในการ
ปฏิบติังาน 

3) ในระหว่างปฏิบติังานเกิดขอ้ผิดพลาดในการท างานท าให้รายงานไม่สามารถด าเนิน
ต่อไปได ้

 

แนวทางแกไ้ขปัญหามีดงัน้ี 

 1) ศึกษาหาความรู้ดว้ยตนเอง ผา่นเวบ็ไซตส์อนการเขียนโคด้ 

 2) พยายามไม่เปิดโปรแกรมเยอะๆระหวา่งการท างาน เพื่อป้องกนัโปรแกรมคา้ง 

 3) พยายามหาวธีิการแกไ้ขปัญหาโดยการคน้หาขอ้มูลในเวบ็ไซต ์และถามพี่เล้ียง 

 

5.3 ข้อเสนอแนะจากการด าเนินงาน 

 1) หมัน่ฝึกฝนทกัษะการเขียนโปรแกรมอยูส่ม ่าเสมอ 

 2) ใหท้างมหาลยัเพิ่มหลกัสูตร สอนการใชค้ริสตลั รีพอร์ท และบูทสแตรป 

 3) ตอ้งหมัน่ใฝ่หาความรู้ใหม่ๆอยูเ่สมอ 
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ภาคผนวก ก. 

การตดิตั้งโปรแกรมต่างๆ 

 

 

 

 

 

 

 

 

 



 
 

การติดตั้งโปรแกรม ไมโครซอฟท์ วิชวล สตูดิโอ 

► Download .NET Framework 4.5 Microsoft Soft .NET Package Install 

http://www.thaicreate.com/asp.net/install-dot-net-framework4.5.html 

 

► ส ำหรับ Feature ใหม่ ๆ ของ .NET 4.5 คือ 

- .NET for Metro style Apps 

- Portable Class Libraries 

- Core New Features and Improvements 

- Windows Presentation Foundation (WPF) 

- Windows Communication Foundation (WCF) 

- Windows Workflow Foundation (WF) 

 

► สำมำรถอ่ำนเพิ่มเติมไดท่ี้ 

http://msdn.microsoft.com/en-us/library/ms171868(v=vs.110).aspx 

 

► กรณีท่ีดำวน์โหลด .NET Framework 4.5 จำกตวั Web Installer สำมำรถอ่ำนไดจ้ำกล้ิงคข์ำ้งบน 

หรือจะติดตั้งพร้อมกบั Visual Studio 2012 ตำมบทควำมน้ี 

 

► Download Visual Studio 2012 

http://www.microsoft.com/visualstudio/11/en-us/downloads#vs 

 

► เม่ือคลิกเขำ้ไปใน Visual Studio 2012 จะแบ่งออกเป็นหลำยตวั ในท่ีน้ีจะเลือกเวอร์ชนัท่ีเป็น
แบบ Visual Studio Professional 

 

http://www.thaicreate.com/asp.net/install-dot-net-framework4.5.html
http://www.thaicreate.com/outlink.php?l=http://www.microsoft.com/visualstudio/11/en-us/downloads#vs


 
 

►เลือกแบบ Web Installer 

 

รูปที ่1ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์วชิวล สตูดิโอ 1 

 

►ไดเ้ป็น Package Install ใหด้บัเบิ้ลคลิกเพื่อติดตั้ง 

 

รูปที ่2ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์วชิวล สตูดิโอ 2 

 

 

 



 
 

► แสดง Logo ของ Visual Studio 2012 ใหร้อซกัครู่ 

 

รูปที ่3ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์วชิวล สตูดิโอ 3 

 

► คลิกเลือก Checkbox ท่ีวำ่ I agree to the License terms and conditions และ Next เพื่อไปยงั
ขั้นตอนถดัไป 

 

รูปที ่4ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์วชิวล สตูดิโอ 4 

 

 



 
 

► เลือก Optional features to install ใหเ้ลือกทั้งหมดเลยก็ได ้แต่จะตอ้งมีเน้ือท่ีเหลือใน HDD ไม่
นอ้ยกวำ่ 8-9 G จำกนั้นใหค้ลิกท่ี Install 

 

รูปที ่5ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์วชิวล สตูดิโอ 4 

 

► โปรแกรมก ำลงัติดตั้ง ซ่ึงจะใชเ้วลำประมำณ 1-3 ชม  

 

รูปที ่6ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์วชิวล สตูดิโอ 5 



 
 

► รอจนกวำ่จะติดตั้งเรียบร้อย หลงัจำกนั้นก็ Restart เคร่ืองซะ 1 รอบ 

 

รูปที ่7ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์วชิวล สตูดิโอ 6 

 
 
 

 

 

 

 

 

 

 

 



 
 

การติดตั้งโปรแกรม แบรคคทิ 

► ใหไ้ปท่ีเวบ็ไซต ์http://brackets.io 

► เลือกดำวน์โหลด  

 

รูปที ่8ก ขั้นตอนกำรติดตั้งแบรคคิท 1 

 

► เลือกต ำแหน่งท่ีจะเก็บไฟล ์แลว้คลิกท่ีปุ่ม Save 

 

รูปที ่9ก ขั้นตอนกำรติดตั้งแบรคคิท 2 

http://brackets.io/
http://www.konkeanweb.com/wp-content/uploads/2014/09/brackets-download-installing-windows-8-2.png
http://www.konkeanweb.com/wp-content/uploads/2014/09/brackets-download-installing-windows-8-3.png


 
 

► เม่ือดำวน์โหลดเสร็จก็ใหไ้ปเช็คดูวำ่ มีไฟลแ์บบน้ีแลว้หรือยงั ถำ้มีก็ใหด้บัเบิลคลิก หรือจะคลิก
ขวำเลือก Run as administrator ก็ได ้

 

รูปที ่10ก ขั้นตอนกำรติดตั้งแบรคคิท 3 

 

► เลือก path ท่ีจะติดตั้งแลว้คลิกท่ีปุ่ม Next 

 

รูปที ่11ก ขั้นตอนกำรติดตั้งแบรคคิท 4 

 

 

http://www.konkeanweb.com/wp-content/uploads/2014/09/brackets-download-installing-windows-8-4.png
http://www.konkeanweb.com/wp-content/uploads/2014/09/brackets-download-installing-windows-8-5.png


 
 

►ติดตั้งดว้ยกำรคลิกท่ีปุ่ม Install 

 

รูปที ่12ก ขั้นตอนกำรติดตั้งแบรคคิท 5 

 

►รอจนกวำ่จะติดตั้งแลว้เสร็จ 

 

รูปที ่13ก ขั้นตอนกำรติดตั้งแบรคคิท 6 

 

 

http://www.konkeanweb.com/wp-content/uploads/2014/09/brackets-download-installing-windows-8-6.png
http://www.konkeanweb.com/wp-content/uploads/2014/09/brackets-download-installing-windows-8-7.png


 
 

► ติดตั้งเสร็จเรียบร้อย ให้คลิกปุ่ม Finish 

 

รูปที ่14ก ขั้นตอนกำรติดตั้งแบรคคิท 7 

 

► เม่ือลองคน้หำดว้ยค ำวำ่ Brackets จำกหนำ้ home screen ของ windows 8 ก็จะเจอ 

 

รูปที ่15ก ขั้นตอนกำรติดตั้งแบรคคิท 8 

 

 

 

http://www.konkeanweb.com/wp-content/uploads/2014/09/brackets-download-installing-windows-8-8.png
http://www.konkeanweb.com/wp-content/uploads/2014/09/brackets-download-installing-windows-8-9.png


 
 

► หนำ้แรกของ editor 

 

รูปที ่16ก ขั้นตอนกำรติดตั้งแบรคคิท 9 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

http://www.konkeanweb.com/wp-content/uploads/2014/09/brackets-download-installing-windows-8-10.png


 
 

การติดตั้ง คริสตัล รีพอร์ท 

► ให้ดาวน์โหลดได้ที่ 

http://www.businessobjects.com/jump/xi/crvs2010/us2_default.asp 

► เลือก Version ท่ีช่ือวำ่ "SAP Crystal Reports, version for Visual Studio 2010 - Standard" 

► หลงัจำกท่ีไดไ้ฟลแ์ลว้ใหด้บัเบิ้ลคลิกท่ี Package เพื่อ Install 

 

รูปที ่17ก ขั้นตอนกำรติดตั้งคริสตลั รีพอร์ท 1 

 

► รอซกัครู่ ก ำลงัแตกไฟลเ์พื่อ Install 

 

รูปที ่18ก ขั้นตอนกำรติดตั้งคริสตลั รีพอร์ท 2 

 

 



 
 

► เลือกภำษำ 

 

รูปที ่19ก ขั้นตอนกำรติดตั้งคริสตลั รีพอร์ท 3 

 

► ก ำลงั Install  

 

รูปที ่20ก ขั้นตอนกำรติดตั้งคริสตลั รีพอร์ท 4 

 

► รอซกัครู่ 

 

รูปที ่21ก ขั้นตอนกำรติดตั้งคริสตลั รีพอร์ท 5 



 
 

► คลิกท่ี Next เพื่อไปยงัขั้นตอนถดัไป 

 

รูปที ่22ก ขั้นตอนกำรติดตั้งคริสตลั รีพอร์ท 6 

 

► คลิกเลือกท่ี I accept the License Agreement และ Next เพื่อไปขั้นตอนถดัไป 

 

รูปที ่23ก ขั้นตอนกำรติดตั้งคริสตลั รีพอร์ท 7 
 

 
 



 
 

► ก ำลงัติดตั้งซ่ึงจะใชเ้วลำรำว 15-30 นำที 

 

รูปที ่24ก ขั้นตอนกำรติดตั้งคริสตลั รีพอร์ท 8 

 

► กำรติดตั้งสมบูรณ์ 

 

รูปที ่25ก ขั้นตอนกำรติดตั้งคริสตลั รีพอร์ท 9 



 
 

การติดตั้งไมโครซอฟท์ เอสควิแอลเซิร์ฟเวอร์ 

► ดำวน์โหลดไดท่ี้ https://www.microsoft.com/en-hk/download/details.aspx?id=30438 

► คลิกเลือกท่ี Installation และคลิกท่ี New installation or add features to an existing 
installation ตำมล ำดบั 

 

รูปที ่26ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์เอสคิวแอลเซิร์ฟเวอร์ 1 

 

► คลิก OK 

 

รูปที ่27ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์เอสคิวแอลเซิร์ฟเวอร์ 2 

 



 
 

► ป้อน Serial Number และคลิก Next 

 

รูปที ่28ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์เอสคิวแอลเซิร์ฟเวอร์ 3 

 

► เลือก I accept the license terms. และคลิก Next 

 

รูปที ่29ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์เอสคิวแอลเซิร์ฟเวอร์ 4 

 



 
 

► คลิก Install 

 

รูปที ่30ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์เอสคิวแอลเซิร์ฟเวอร์ 5 

 

► คลิก Next 

 

รูปที ่31ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์เอสคิวแอลเซิร์ฟเวอร์ 6 

 



 
 

► คลิก All Features With Defaults และคลิก Next 

 

รูปที ่32ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์เอสคิวแอลเซิร์ฟเวอร์ 7 

 

► คลิก Next 

 

รูปที ่33ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์เอสคิวแอลเซิร์ฟเวอร์ 8 

 



 
 

► คลิก Next 

 

รูปที ่34ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์เอสคิวแอลเซิร์ฟเวอร์ 9 

 

► คลิก Next 

 

รูปที ่35ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์เอสคิวแอลเซิร์ฟเวอร์ 10 

 



 
 

►คลิก Next 

 

รูปที ่36ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์เอสคิวแอลเซิร์ฟเวอร์ 11 

 

► แกไ้ขเป็น NT AUTHORITY\SYSTEM และคลิกแทบ็ Collection 

 

รูปที ่37ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์เอสคิวแอลเซิร์ฟเวอร์ 12 

 



 
 

► แกไ้ขเป็น Thai_CI_AS และคลิก Next 

 

รูปที ่38ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์เอสคิวแอลเซิร์ฟเวอร์ 13 

 

►เลือก Mixed Mode (SQL Server authentication and Windows authentication) พร้อม
ใส่ Passwordท ำกำรเพิ่มผูใ้ชง้ำน เสร็จแลว้คลิก Next 

 

รูปที ่39ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์เอสคิวแอลเซิร์ฟเวอร์ 14 



 
 

► คลิก Add Current User 

 

รูปที ่40ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์เอสคิวแอลเซิร์ฟเวอร์ 15 

 

► คลิก Next 

 

รูปที ่41ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์เอสคิวแอลเซิร์ฟเวอร์ 16 

 



 
 

► คลิก Install the native mode default configuration. และคลิก Next 

 

รูปที ่42ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์เอสคิวแอลเซิร์ฟเวอร์ 17 

 

► คลิก Next 

 

รูปที ่43ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์เอสคิวแอลเซิร์ฟเวอร์ 18 

 



 
 

► คลิก Next 
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► คลิก Install 

 

รูปที ่45ก ขั้นตอนกำรติดตั้งไมโครซอฟท ์เอสคิวแอลเซิร์ฟเวอร์ 20 

 



 
 

► คลิก Close เพียงเท่ำน้ีก็เสร็จส้ินขั้นตอนกำรติดตั้ง MS SQL Server เรียบร้อยแลว้ 
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การติดตั้งโปรแกรม แซมป์ 

► ก่อนติดตั้ง XAMPP ควรอยำ่งยิง่ท่ีจะท ำกำร Uninstall ระบบจ ำลอง Webserver ตวัอ่ืนๆ ใน

ระบบ Windows เรำเสียก่อน เช่น Appserv / IIS เป็นตน้ 

► RAM ไม่ต ่ำกวำ่ 128 MB Hard Disk มีเน้ือท่ีวำ่งมำกกวำ่ 320 MB ส่วน CPU ไม่ก ำหนดระบบ

ขั้นต ่ำ 

► Download ชุดติดตั้งจำก http://www.apachefriends.org/  

► ปิด Antivirus ใหเ้รียบร้อย 

► เปิดไฟลท่ี์ใชใ้นกำรติดตั้ง xampp-win32-5.6.3-0-VC11-installer 

► กด Next 

 

รูปที ่47ก ขั้นตอนกำรติดตั้งแซมป์ 1 

 

 

 

http://www.apachefriends.org/


 
 

► เลือกทั้งหมด แลว้ใหค้ลิก Next เพื่อไปขั้นตอนถดัไป 
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► เลือก Directory ท่ีตอ้งกำร กด Next 

► กด Next เพื่อท ำกำรติดตั้ง 
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วธีิการเปิดโปรแกรม 

► เขำ้ไปท่ีหนำ้ XAMPP Control Panel แลว้ดบัเบิ้ลคลิกเพื่อเปิดโปรแกรมข้ึนมำ 
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► เปิด Apache และ MySQL เพื่อรัน PHP 
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► หำกรันโปรแกรมส ำเร็จจะข้ึนเป็นแถบสีเขียว 
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► เขำ้ Web Browser แลว้พิมพ ์URL วำ่ localhost จะข้ึนหนำ้เวบ็ Xampp ข้ึนมำ จะถือวำ่ กำร

จ ำลองโปรแกรม Server ส ำเร็จ 
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ภาคผนวก ข. 

โค้ดการออกรายงานด้วย คริสตลั รีพอร์ท 

 

 

 

 

 

 

 

 

 



 
 

การออกรายงานด้วย คริสตัล รีพอร์ท 

► โคด้ เพื่อออกรำยงำนเป็น PDF ธรรมดำ 
public ActionResult ExportReport2() 
        { 
 
            ReportDocument rd = new ReportDocument(); 
            rd.Load(Path.Combine(Server.MapPath("~/Reports"), "SuitabilityTest.rpt")); 
            Response.Buffer = false; 
            Response.ClearContent(); 
            Response.ClearHeaders(); 
            try 
            { 
                Stream stream = 
rd.ExportToStream(CrystalDecisions.Shared.ExportFormatType.PortableDocFormat); 
                stream.Seek(0, SeekOrigin.Begin); 
                return File(stream, "application/pdf", "SuitabilityTest.pdf"); 
            } 
            catch (Exception ex) 
            { 
                throw; 
            } 
        } 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

► โคด้ เพื่อออกรำยงำนเป็น PDF มีกำรดึงขอ้มูลจำกฐำนขอ้มูล แบบ 1 ตำรำง 
public ActionResult ExportReport3() 
        { 
            var d = (from s in db.SUPPLEMENT_ACCOUNT 
                     where s.CUSTOMER_ID == 4 
                     select new 
                     { 
                         NAME = s.NAME ?? "", 
                         ACC_NO = s.ACC_NO ?? "", 
                         BENEFICARY_NAME = s.BENEFICARY_NAME ?? "", 
                         TELEPHONE = s.TELEPHONE ?? "", 
                         MOBILE = s.MOBILE ?? "", 
                         EMAIL = s.EMAIL ?? "", 
                     }).ToList(); 
 
            ReportDocument rd = new ReportDocument(); 
            rd.Load(Path.Combine(Server.MapPath("~/Reports"), "SupplementForm.rpt")); 
            rd.SetDataSource(d); 
            Response.Buffer = false; 
            Response.Clear(); 
            Response.ClearContent(); 
            Response.ClearHeaders(); 
            try 
            { 
                Stream stream = 
rd.ExportToStream(CrystalDecisions.Shared.ExportFormatType.PortableDocFormat); 
                stream.Seek(0, SeekOrigin.Begin); 
                return File(stream, "application/pdf", "SupplementFormVerEng.pdf"); 
            } 
            catch (Exception ex) 
            { 
                throw; 
            } 
        } 
 

 

 

 

 

 

 

 

 

 

 



 
 

► โคด้ เพื่อออกรำยงำนเป็น PDF มีกำรดึงขอ้มูลจำกฐำนขอ้มูล แบบ 2 ตำรำงข้ึนไป 
public ActionResult ExportReport() 
        { 
            var data = (from p in db.PERSONAL_DETAIL 
                        join m in db.PERSONAL_MARITAL_DETAIL 
                            on p.PERSONAL_ID equals m.PERSONAL_ID 
                        join b in db.PERSONAL_BUSINESS_OR_OCCUPATION 
                            on m.PERSONAL_ID equals b.PERSONAL_ID 
                        where m.PERSONAL_ID == 7 
                     select new 
                     { 
                         //db.PERSONAL_DETAIL 
                         PERSONAL_ID = p.PERSONAL_ID, 
                         CUSTOMER_ID = p.CUSTOMER_ID, 
                         TITLE = p.TITLE, 
                         FIRSTNAME_TH = p.FIRSTNAME_TH ?? "", 
                         LASTNAME_TH = p.LASTNAME_TH ?? "", 
                         FIRSTNAME_EN = p.FIRSTNAME_EN ?? "", 
                         LASTNAME_EN = p.LASTNAME_EN ?? "", 
                         BIRTH_DATE = p.BIRTH_DATE, 
                         NATIONALITY = p.NATIONALITY ?? "", 
                         PLACE_TH = p.PLACE_TH, 
                         PLACE_OTHER = p.PLACE_OTHER ?? "", 
                         ID_CARD = p.ID_CARD ?? "", 
                         ISSUE_DATE = p.ISSUE_DATE, 
                         EXPIRE_DATE = p.EXPIRE_DATE, 
                         REGISTERED_ADDRESS = p.REGISTERED_ADDRESS ?? "", 
                         CONTACT_ADDRESS = p.CONTACT_ADDRESS ?? "", 
                         TELEPHONE = p.TELEPHONE ?? "", 
                         FAX = p.FAX ?? "", 
                         MOBILE = p.MOBILE ?? "", 
                         MAIL = p.MAIL ?? "", 
                         VAT_REGISTERATION = p.VAT_REGISTERATION, 
                         MARITAL_STATUS = p.MARITAL_STATUS, 
                         EDUCATION_LEVEL_ID = p.EDUCATION_LEVEL_ID, 
                         //db.PERSONAL_MERITAL_DETAL 
                         ID = m.FIRST_NAME ?? "", 
                         FIRST_NAME = m.LAST_NAME ?? "", 
                         LAST_NAME = m.LAST_NAME ?? "", 
                            //NATIONALITY = m.NATIONALITY as MERITAL_NATIONALITY, 
                         AGE = m.AGE ?? "", 
                         OCCUPATION = m.OCCUPATION ?? "", 
                         COMPANY_NAME = m.COMPANY_NAME ?? "", 
                         BUSINESS_TYPE = m.BUSINESS_TYPE ?? "", 
                         POSITION = m.POSITION ?? "", 
                            //TELEPHONE = m.TELEPHONE ?? "", 
                         INCOME = m.INCOME ?? 0, 
                         OTHER_INCOME = m.OTHER_INCOME ?? 0, 
                         INCOME_SOURCE = m.INCOME_SOURCE ?? "", 
                         //db.BUSINESS_OR_OCCUPATION 
                            //ID = b.ID ?? "", 
                            //OCCUPATION = b.OCCUPATION, 
                         OCCUPATION_HOUSE_WIFE = b.OCCUPATION_HOUSE_WIFE ?? "", 
                         OCCUPATION_HOUSE_RETIRED = b.OCCUPATION_HOUSE_RETIRED ?? "", 
                            //BUSINESS_TYPE = b.BUSINESS_TYPE ?? "", 
                         BUSINESS_TYPE_OTHER = b.BUSINESS_TYPE_OTHER ?? "", 
                            //COMPANY_NAME = b.COMPANY_NAME ?? "", 
                            //POSITION = b.POSITION ?? "", 
                         YEAR_OF_SERVICE = b.YEAR_OF_SERVICE ?? 0, 
                         ADDESS = b.ADDESS ?? "" 
                            //TELEPHONE 
                            //FAX 
                            //SOURCE_INCOME 
                            //SOURCE_INCOME_OTHER 
                         }).ToList(); 
 
            ReportDocument rd = new ReportDocument(); 
            rd.Load(Path.Combine(Server.MapPath("~/Reports"), "report.rpt")); 



 
 

            Response.Buffer = false; 
            rd.SetDataSource(data); 
            rd.SetDatabaseLogon("dba", "12345678"); 
            Response.ClearContent(); 
            Response.ClearHeaders(); 
            Response.Clear(); 
          
            try 
            { 
                Stream stream = 
rd.ExportToStream(CrystalDecisions.Shared.ExportFormatType.PortableDocFormat); 
                stream.Seek(0, SeekOrigin.Begin); 
                return File(stream, "application/pdf", "IndividualAccountAppForm.pdf"); 
            } 
            catch (Exception ex) 
            { 
                throw; 
            } 
        } 

 

► กำรเขียนโคด้สร้ำงค่ำเช็ค แสดงผลเป็น Checkbox  
if {PERSONAL_DETAIL.PLACE_TH} = True then 

    Chr(254) //มเีครื่องหมายถกู 

else 

    Chr(168) //ไม่มเีครื่องหมายถกู 

 

 

 

 

 

 

 

 

 



 
 

 

 

 

 

 

 

 

 

ภาคผนวก ค. 

โค้ดการออกแบบส่วนของผู้ใช้งานด้วย บูทสแตรป 

 

 

 

 

 

 

 

 

 

 



 
 

การออกแบบส่วนของผู้ใช้งานด้วย บูทสแตรป 

► ส่วน Header และกำรท ำแฮมเบอร์เกอร์ 

<nav class="navbar navbar-default navbar-header-tap2pay "> 

        <div class="container-fluid"> 

            <!-- Brand and toggle get grouped for better mobile display --> 

            <div class="navbar-header"> 

                <button type="button" class="navbar-toggle collapsed" data-toggle="collapse" 

                        data-target="#bs-example-navbar-collapse-1" aria-expanded="false"> 

                    <span class="sr-only">Toggle navigation</span> 

                    <span class="icon-bar"></span> 

                    <span class="icon-bar"></span> 

                    <span class="icon-bar"></span> 

                </button> 

                <img class="logo-t2p" src="images/pic/logo-01.png" width="120"/> 

            </div> 

            <!-- Collect the nav links, forms, and other content for toggling --> 

            <div class="collapse navbar-collapse " id="bs-example-navbar-collapse-1"> 

                <ul class="nav navbar-nav navbar-right"> 

                    <li class="active"><a href="Index.html">Application</a></li> 

                    <li><a href="#feature">Feature</a></li> 

                    <li><a href="#hardware">Hardware</a></li> 

                    <li><a href="faq.html">FAQ</a></li> 

                    <li><a href="#contact">Contact us</a></li> 

                    <li><button class="btn-sign-in btn">Sign In</button></li> 

                </ul> 

            </div> 

            <!-- /.navbar-collapse --> 

        </div> 

        <!-- /.container-fluid --> 

</nav> 

 

 

 

 



 
 

► คลิกและเก็บแถบเมนู 
$(".navbar-nav > li").click(function () { 

            $(".navbar-toggle").click(); 

}); 

 

► กำรท ำ one page 
$('#nav').onePageNav({ 

        currentClass: 'active', 

        changeHash: false, 

        scrollSpeed: 750, 

        scrollOffset: 48, 

        scrollThreshold: 0.5, 

        filter: '', 

        easing: 'swing', 

        begin: function () { 

            //I get fired when the animation is starting 

        }, 

        end: function () { 

            //I get fired when the animation is ending 

        }, 

        scrollChange: function ($currentListItem) { 

 

        } 

    }); 

 

► กำรใส่แผนท่ี 
<div id="map" class="map section section-table"> 

        <div class="wrapper-section container-fulid"> 

            <iframe width="100%" height="300" frameborder="0" style="border:0"            
src="https://www.google.com/maps/embed/v1/place?q=place_id:ChIJyRMMZvKf4jAR4U26g-
K2If8&key=AIzaSyAxY4gUNoJ2oGOe5ObLW4zkRc0A58TYKtk" allowfullscreen></iframe> 

        </div> 

</div> 



111 
 

ประวตัผิู้วจิยั 

 

ช่ือ – สกุล   นางสาวสุขปียา  เจริญลาภกุล 
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ประวตัิการศึกษา 
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